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      Chapter 1. Breaking the Ice: Introducing AI for Excel

      
      

A Note for Early Release Readers


With Early Release ebooks, you get books in their earliest form—the author’s raw and unedited content as they write—so you can take advantage of these technologies long before the official release of these titles.


This will be the 1st chapter of the final book. Please note that the GitHub repo will be made active later on.


If you have comments about how we might improve the content and/or examples in this book, or if you notice missing material within this chapter, please reach out to the editor at ccollins@oreilly.com.



      If you have worked with Microsoft Excel, you’ve probably noticed how tiring and sometimes boring it is to perform repetitive operations such as formatting cells or doing calculations. By searching the web, you have probably found ways to navigate the jungle of data analysis, formulas, and formatting, but you keep encountering new problems that slow down your work. If you’re not that familiar with Excel, you may be intimidated by the challenges you’ll undoubtedly face when manipulating data. That has happened to me many times. 

      When I was 15 I started using Excel to catalog the books on my shelf. At the time, a quarter of a century ago, I was using Microsoft Excel 1995. But later, even after I had been working with Excel for a long time, every time a new problem arose, I had to search the Web or look at books for answers.

      Today, everything has changed with the advent of generative AI, which has introduced new ways of working and speeding up tedious tasks. Generative AI is a potent tool that allows you to quickly manipulate and generate data. However, to make the best use of it, you need to know it, learn its limits, and see how far it can help you. 

      This chapter begins your journey to discover how to integrate generative AI into Excel. This technology is evolving so fast that the AI models coming out today may seem old quickly. However, the principles described in this book are always valid, and you can apply them even if the technologies described become obsolete. 

      So what are we waiting for? Let’s go. This chapter covers the following:

      
        	
          Basic Excel concepts

        

        	
          Why Excel needs AI

        

        	
          The benefits of using AI in Excel

        

        	
          When AI is not helpful in Excel

        

        	
          Browsing the different AI tools for Excel

        

      

      
        Basic Excel Concepts

        As you probably know, Microsoft Excel is a very popular tool for processing different types of data. You can use it to display and manipulate tables, build and enrich graphs, extract knowledge, and much more. Whatever reason you use Excel for, you will surely deal with data. Data is the raw element representing an observation or measurement before any interpretation or processing. Data can be numbers or texts. For example, if the number of clouds you see in the sky today is 10, it means that 10 is a data point that represents the number of clouds. Today’s date is another data point, and the category cloud is another data point. Imagine that every day, you count not only the number of clouds you see in the sky but also the number of birds, which represent a second category, and you organize everything into a table like Table 1-1.

        
          Table 1-1. Sky dataset with the number of clouds and the number of birds organized by day.
          
            
              	Date
              	Number
              	Category
            

          
          
            
              	
                2024-09-28

              
              	
                10

              
              	
                Cloud

              
            

            
              	
                2024-09-29

              
              	
                12

              
              	
                Cloud

              
            

            
              	
                2024-09-30

              
              	
                0

              
              	
                Cloud

              
            

            
              	
                2024-09-28

              
              	
                13

              
              	
                Bird

              
            

            
              	
                2024-09-29

              
              	
                7

              
              	
                Bird

              
            

            
              	
                2024-09-30

              
              	
                9

              
              	
                Bird

              
            

          
        

        What you have there is a dataset. A dataset is, very simply, a set of data. In Excel, you can load several datasets, one at a time or all at once. 

        Before we move forward, let’s clarify some Excel definitions you will see throughout the book:

        
          	
            A cell is the basic unit of a table, located at the intersection of a row and a column of the table, where you can enter data or formulas.

          

          	
            A worksheet is a sheet within a work file, organized into rows and columns, where data can be inserted, viewed, and manipulated.

          

          	
            A workbook is a file that contains one or more worksheets. It allows you to organize and manage different data tables within the same document.

          

          	
            A range is a set of selected cells. One row is a single horizontal row of cells, while a column is a vertical column of cells within a worksheet.

          

        

        Note

          To illustrate AI in Excel, much of this chapter will have you doing an exercise in Excel. If you know Excel like the back of your hand, this exercise will be child’s play.

        

        Consider the dataset on submarine cables in the United States released by Marine Cadastre and usable under the CC0-1.0 license. The dataset is constantly updated. We will use the September 26, 2024 version, which you can download from the book’s GitHub repository under 01/ch01.csv. 

        This dataset contains the approximate location of commercial and research submarine cables in U.S. waters. Most of these cables are used for communications, while a smaller portion is used for power transmission. In coastal areas, cables are usually buried under the seabed, while in the open sea, they are laid directly on the seabed. Just to get an idea of ​​what we’re talking about, Figure 1-1 shows a portion of the data plotted on a US East Coast map. Each line corresponds to a submarine cable.

        
          [image: A map of the united states  AI-generated content may be incorrect.]
          Figure 1-1. A map representation of a portion of the U.S. submarine cable dataset.

        

        All the data shown in Figure 1-1 are organized in a table. Table 1-2 shows a portion of the U.S. submarine cable dataset.

        
          Table 1-2. A portion of the U.S. submarine cable dataset.
          
            
              	owner
              	cablesystem
              	region
              	SHAPE__Length
              	shortname
              	objectid
              	SHAPE__Area
              	status
            

          
          
            
              	
                AT&T Corp

              
              	
                Americas II

              
              	
                East Coast

              
              	
                108697.599067727

              
              	
                Americas II 12

              
              	
                1

              
              	
                3692268.78287065

              
              	
                In Service

              
            

            
              	
                GCI Communication Corp

              
              	
                AU-Aleutian Submarine Cable System

              
              	
                Pacific Northwest

              
              	
                1129434.70407587

              
              	
                AU-Aleutian A

              
              	
                2

              
              	
                59147025.5701272

              
              	
                In Service

              
            

            
              	
                GU Holdings Inc

              
              	
                Curie

              
              	
                West Coast

              
              	
                1274007.14615703

              
              	
                Curie 1.1

              
              	
                12

              
              	
                46186616.5743059

              
              	
                In Service

              
            

            
              	
                Eversource Energy

              
              	
                Eversource HEEC Cable

              
              	
                East Coast

              
              	
                10111.1441552573

              
              	
                Eversource

              
              	
                13

              
              	
                412285.08210812

              
              	
                In Service

              
            

            
              	
                GU Holdings Inc

              
              	
                Firmina

              
              	
                East Coast

              
              	
                1006081.05355044

              
              	
                Firmina

              
              	
                14

              
              	
                36427384.0707461

              
              	
                In Service

              
            

            
              	
                GU Holdings Inc

              
              	
                Grace Hopper

              
              	
                East Coast

              
              	
                1493252.13857506

              
              	
                Grace Hopper

              
              	
                15

              
              	
                59139244.8171426

              
              	
                In Service

              
            

          
        

        The dataset contains the following fields:

        
          	
            Owner: The entity that owns the cable. It is a company or an organization

          

          	
            Cable System: The full name of the submarine cable system to which the cable belongs

          

          	
            Region: The geographic region where the cable is located

          

          	
            SHAPE__Length: The cable’s length

          

          	
            Short Name: The short name of the submarine cable

          

          	
            Objectid: A unique identifier for each object in the dataset 

          

          	
            SHAPE__Area: The geographic area occupied by the cable

          

          	
            Status: The current status of the cable.

          

        

        In the remainder of this section, we’ll use this dataset to see how to use Excel for different purposes, including data management, analysis, and visualization. You will see the other cases later in the book. 

        
          Excel for Data Management

          Data management involves collecting, organizing, storing, and maintaining data while ensuring its accessibility and security. The first step to managing data is to load the dataset as a table. Excel supports various formats, such as CSV, but to fully exploit its potential, here you will save the dataset in XLSX format, which is Excel’s proprietary format.

          Download the dataset from the GitHub repository of the book under 01/ch01.csv and save it in your local filesystem. Then, load it into Excel. If this is your first time using Microsoft Excel, perform the following steps to load the example dataset into Excel:

          
            	
              Launch Excel, then select File → Open → Select your file → Open → Choose the dataset from your filesystem → Check Delimited. Click Next → Select Comma as a delimiter, then click Next.

            

            	
              For each column, select the format. For now, leave the default values and click Finish.

            

            	
              If a warning screen appears about possible information loss, proceed to save the file as an Excel file by clicking Save As. On the screen that opens, select XLSX as the File Format. Then click Save. 

            

          

          Figure 1-2 shows a portion of the dataset loaded into Excel.

          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 1-2. A portion of the dataset loaded into Excel.

          

          The dataset is not yet formatted as a table. A table in Excel is a tool that helps you organize data more efficiently than a regular range of cells. Using a table has several benefits, such as using column names instead of cell ranges. As you’ll see later in the book, Copilot, the AI ​​tool integrated with Excel, works only with tables.

          Select Format as Table from the Ribbon Home tab to turn your raw data into a table. In the next window, select the table layout and leave the columns selected by default. Also, make sure there is a checkmark on the entry “My table has headers.” Before we start working, let’s give the table a name. Select the Table tab from the Ribbon and change the table’s name to MainTable in the Table Name box on the left, as shown in Figure 1-3.

          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 1-3. How to rename a table in Excel.

          

          At this point, you are ready to work.

          Note

            The Ribbon in Excel is the toolbar at the top of the Excel window. It organizes commands and features into tabs, such as Home, Insert, and Formulas, as shown in Figure 1-4.

          

          
            
            Figure 1-4. The Ribbon in Excel. 

          

        

        
          Excel for Data Analysis

          The second main purpose of using Excel is data analysis, which allows you to carry out mathematical and financial calculations. Excel offers various formulas and functions for performing numerical, financial, and statistical calculations, such as sums, averages, and so on.

          Let’s query the dataset by building a new table with the number of In Service, Planned, and Out of Service cables. We will call this table StatusTable. Many data points are unavailable, so they will be excluded from our calculation. To build the StatusTable:

          
            	
              Click in whatever cell out of the main table. 

            

            	
              Write the data values shown in Table 1-3, one for each cell, as shown in Figure 1-5.

            
          
            Table 1-3. The data values for the StatusTable.
            
              
                	status
                	count
              

            
            
              
                	
                  In Service

                
                	
              

              
                	
                  Planned

                
                	
              

              
                	
                  Out of Service

                
                	
              

            
          

          
            [image: A screenshot of a spreadsheet  AI-generated content may be incorrect.]
            Figure 1-5. A possible place to insert data values. 

          


        
            	
              Format as a table by selecting all the cells involved and clicking on Format as Table, as described previously. Then, rename the table to StatusTable (Figure 1-6).

            

          


          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 1-6. The StatusTable with the possible states. 

          

          As a result, you have built a table with the following values:

          
            	
              The first column contains the status with the three values ​​(In Service, Planned, and Out of Service).

            

            	
              The second column contains only the header (named count), which will include the number of items in the MainTable for each status.

            

          

          To populate the count column values automatically, you must calculate the number of cables in the In Service state using Excel formulas. To access a formula, select it from the Formulas tab of the Ribbon or proceed as follows:

          
            	
              Double-click the first cell of the count column and insert the equals (=) symbol. This opens formula mode, where you can enter any formulas you like. 

            

            	
              You will use a conditional count, which counts rows from the status column of the main table only if they satisfy a criterion. Enter the following formula and press Enter:

              =COUNTIF(MainTable[status]; [@status])

            

          

          The formula means that we use the COUNTIF function to count the cells in the status column of the MainTable table only if they meet a particular criterion specified by the function’s second parameter. The criterion is this: a cell is counted only if its value matches the current row’s value in the status column. In other words, the [@status] function refers to the value of the status column in the currently processed row within the table. So, the formula is counting how many times the value of the current row’s status column appears in the entire status column of the MainTable table. 

          To make the formula effective, click the cell where you wrote the formula. A small square appears at the bottom right of the cell. Drag the cell down to the last row of the StatusTable. The fields will be automatically populated with the correct values. Figure 1-17 shows the final result.

          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 1-7. The StatusTble filled with missing values. 

          

          You can achieve the same result as the previous example using pivot tables. A pivot table is a table for dynamically summarizing, analyzing, exploring, and presenting data. Follow these steps:

          
            	
              Select the Insert tab from the Ribbon and then Pivot Table. 

            

            	
              In the open window, select the status column (click the letter H to select the entire column) and then click OK.

            

            	
              In the box that opens on the right, select the status column and drag it into the ∑ Values ​​area. Excel automatically populates the table, adding the states we had not considered in the previous example. 

            

          

          Figure 1-8 shows the newly built pivot table.

          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 1-8. The PivotTable for the different statuses. 

          

        

        
          Excel for Data Visualization

          A third use of Excel is data visualization, which involves representing data through graphs, such as lines, bar graphs, or pie charts. Follow these steps to draw a bar chart of the pivot table:

          
            	
              Click anywhere inside your pivot table.

            

            	
              Select the Insert tab on the Excel Ribbon.

            

            	
              In the Charts group, click Histograms → 2D.

            

          

          Figure 1-9 shows the resulting chart.

          
            [image: A graph with blue and white bars  AI-generated content may be incorrect.]
            Figure 1-9. The bar chart built from the pivot table.

          

          This simple exercise has demonstrated some of the main features provided by Excel: 

          
            	
              Importing data in CSV format and transforming it into the XLSX format

            

            	
              Formatting the data as a table

            

            	
              Naming the table

            

            	
              Calculating a simple formula

            

            	
              Using a pivot table

            

            	
              Creating a chart in Excel

            

          

          Excel can also be used for other purposes, such as automating processes and creating financial models. Throughout the book, we will explore these aspects and see how to best use AI to manage them.

        

        
          Exercise

          Solve the following exercise using the Submarine Cable dataset:

          
            	
              Create a new worksheet by clicking the + symbol at the bottom of your page

            

            	
              Rename the worksheet as Pivot Table, using the right-click menu to select Rename. 

            

            	
              In the new worksheet, create a pivot table showing the number of cables, organized by owner, for each status. 

            

          

          The solution to the exercise is in the GitHub repository of the book, under 01/ch01_solution.xlsx.

          For a long time I ignored the existence of tables in Excel, working completely “by hand”. “Working by hand” meant exactly this: applying line after line the colors of my template, the formulas and so on. Then, one fine day I discovered tables, and I understood their importance, when I realized that adding or removing rows to the table was very simple: everything updated automatically. If you haven’t tried tables yet, I suggest you do so soon and you’ll see that your Excel life will improve, as mine has.

        

      

      
        Why Does Excel Need AI?

        So far you have seen Excel can be used for three different purposes: data management, data analysis and data visualization. Indeed, there are other possible uses of Excel as well. Figure 1-10 illustrates some of the many common uses of Excel.

        
          [image: A close-up of several icons  AI-generated content may be incorrect.]
          Figure 1-10. Some of the multiple purposes of using Excel. 

        

        Here’s a bit more about those uses of Excel:

        
          	
            Data management involves using Excel tables to store and organize data, making it easier to sort and filter. For example, you can create a table with customer information and use filters to organize the data. 

          

          	
            Data analysis involves extracting insights from a dataset, for example, applying and analyzing pivot tables. 

          

          	
            Data visualization involves creating charts, such as trends in sales data over time. 

          

          	
            Process automation automates repetitive tasks, such as using macros to format and update tables. 

          

          	
            Financial modeling creates a financial forecast, for example, to predict future cash flows.

          

        

        Excel is already a complete data exploration and analysis tool, so extending it with external tools such as AI might seem excessive. However, there are at least two good reasons to integrate AI tools into Excel.

        The first reason is the increase in productivity, the measure of the efficiency with which you carry out activities. Greater productivity means obtaining more significant results with less resource and time consumption. Combining Excel and AI helps you do the following:

        
          	
            Carry out simple and complex tasks or suggest the steps to carry them out if you are new to Excel

          

          	
            Automate repetitive tasks, such as data cleansing, formatting, or applying formulas, to save time and effort

          

          	
            Process large quantities of data to extract insights

          

          	
            Suggest appropriate visualizations for the data

          

        

        The second reason to integrate AI into Excel concerns improving the accuracy of the results—that is, the ability to produce correct and precise results without errors:

        
          	
            Reduce human errors, which can arise when you enter inputs or calculate values ​​manually

          

          	
            Recognize anomalies that could go unnoticed by the human eye.

          

        

        Let’s look at an example to see how to combine AI and Excel to improve productivity. Consider the dataset from the previous exercise in which you calculated the number of occurrences for each cable status. Let’s do the same exercise again using ChatGPT, one of the most popular AI assistants developed by OpenAI.

        Start ChatGPT. If you don’t have an account yet, visit https://chatgpt.com/ and proceed with registration. In this book, I consider the Plus version of ChatGPT, which requires a monthly subscription, but the suggestions given also apply to the free version, even if the results may be slightly worse. Formulating correct and precise instructions is essential to using ChatGPT and Excel correctly. We will see the structure of the various instructions later in the book. 

        To interact with ChatGPT, you use instructions called prompts. A prompt is a text that describes what ChatGPT should do, and prompt engineering is the art and science of defining appropriate and effective prompts. There are several techniques for defining prompts:

        
          	Zero-shot prompting

          	
            This consists of giving ChatGPT a task without providing examples. Use this technique if you want a quick answer. For example, write: What is Microsoft Excel?.

          

          	One-shot prompting

          	
            Provide a specific example to tell ChatGPT how to respond. For example, write: Microsoft Word is a word processing program developed by Microsoft, which allows you to create, edit, and format text documents professionally. Based on the previous definition, give a Microsoft Excel definition.

          

          	Few-shot prompting

          	
            Give the model multiple examples of how to complete a task. This helps the model better understand the context and format of the desired response. For example, you might provide several examples and then ask for the Microsoft Excel definition.

          

          	Instruction-based prompting

          	
            Give explicit instructions, often in natural language, to clarify the task. For example, you might say, Explain what Microsoft Excel is to a nine-year-old.

          

          	Chain of Thought (CoT) prompting

          	
            Guide ChatGPT to think aloud, breaking down the reasoning step by step, before arriving at an answer. This helps ChatGPT solve complex tasks that require logical reasoning. For example, you could prompt: To explain what Microsoft Excel is, first describe what spreadsheets are, then explain how Excel uses them to organize data, and finally give an example of how it might be used to make a budget.

          

          	Dynamic prompts

          	
            Adapt the prompt based on ChatGPT’s previous answers. This is an interactive approach in which the prompt evolves as the conversation context changes. For example, if ChatGPT just explained what a spreadsheet is, you might build on that answer and ask, Based on your explanation, how might a spreadsheet be used to analyze a company’s expenses?

          

        

        Figure 1-11 summarizes the techniques described.

        
          [image: A close-up of a few words  AI-generated content may be incorrect.]
          Figure 1-11. The different prompt techniques. 

        

        We will see and use these various techniques throughout the book. For now, let’s do a test to evaluate ChatGPT’s potential. 

        
          Excel and AI for Data Management

          In the menu at the top left, select the model used by ChatGPT that is best suited to perform the calculations (ChatGPT version 4o, o1, or o1-mini at the time of writing this book). This exercise gives the data management to ChatGPT, so we load the dataset directly into ChatGPT. 

        

        
          Excel and AI for Data Analysis

          There are two ways of using Excel and ChatGPT. The first consists of carrying out all the analyses in ChatGPT and exporting the final file. The second is to use ChatGPT as an assistant to suggest formulas or procedures for carrying out tasks. This book uses a mixed approach: in some cases, we will use ChatGPT to conduct the analysis, and in others, we will use it as an assistant. You can choose from time to time, based on the situations that arise, which approach to follow. When we talk about Copilot in the second part of the book, we will perform all the operations within Excel, given that Copilot is already integrated into Excel.

          Let’s use the first approach, carrying out all the analysis in ChatGPT and then exporting the final file. Perform the following operations:

          
            	
              Load the dataset ch01.xlsx in ChatGPT, using the paperclip, as shown in Figure 1-12.

          
          
            [image: A screenshot of a chat  AI-generated content may be incorrect.]
            Figure 1-12. How to load a file in ChatGPT. 

          

          

            	
              Write the following prompt in the ChatGPT bar (after loading the dataset):

              Build a pivot table for the column status and count the number of occurrences for each category. 

            

            	
              Press the Enter key. ChatGPT starts thinking. When it has completed processing, it displays descriptive text and a table similar to the one shown in Figure 1-13.

            

          

          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 1-13. The pivot table built by ChatGPT to count different statuses. 

          

          The pivot table calculated by ChatGPT is precisely the same as the one built by Excel in Figure 1-8, with a different formatting style. 

          The next step is to export the output as an Excel file. Write the following prompt in ChatGPT, still in the same chat where you wrote the previous prompt:

          Format the original table and the pivot table as two worksheets of a single workbook in Excel. Calculate the pivot table using formulas instead of raw data. Use column H of the original table in the pivot table formulas. Make the output downloadable as a .xslx file.

          With this prompt, we ask ChatGPT to:

          
            	
              Combine the original table and the generated pivot table in the same Excel file but under two different worksheets.

            

            	
              Calculate the pivot table without hardwiring the numerical values ​​into the table but applying the formulas to calculate them.

            

            	
              Use the original table’s H (status) column to perform calculations in the pivot table. This statement helps ChatGPT calculate the formula precisely.

            

            	
              Make the file downloadable in Excel format.

            

          

          As an output, ChatGPT generates a downloadable file. Download it and open it in Excel (Figure 1-14). 

          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 1-14. The Excel file generated by ChatGPT. 

          

          The downloaded file is very similar to the one we produced manually, with some differences: 

          
            	
              The tables are not formatted like Excel tables.

            

            	
              The pivot table is not a pivot table, as Excel usually calculates it, but it contains formulas to calculate the values ​​correctly.

            

          

          In any case, it’s not a bad starting point. In the same ChatGPT chat, write a new prompt, which is a modified version of the previous one, so that ChatGPT formats the data as Excel tables:

          Format the original table and the pivot table as two Excel tables into two worksheets of a single workbook in Excel. Calculate the pivot table using formulas instead of raw data. Use column H of the original table in the pivot table formulas. Make the output downloadable as a .xslx file.

          Download the generated file and open it with Excel. The data is now formatted as tables, as shown in Figure 1-15. 

          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 1-15. The Excel file generated by ChatGPT with formatted tables. 

          

          The problem of the pivot table remains. Later in the book, you will see how to deal with a problem like this. For now, I hope I’ve convinced you that it’s at least worth using ChatGPT in Excel. 

        

        
          Excel and AI for Data Visualization

          Write the following prompt, always in the same ChatGPT chat:

          Use Excel tools to build a bar chart for the pivot table. Add the chart as an additional worksheet of the previous workbook. Make the output downloadable as a .xslx file.

          Download the generated file. The results are very similar to those you obtained manually, as shown in Figure 1-16, with the only difference being the pivot table (which is not a classic Excel pivot table).

          
            [image: A screenshot of a spreadsheet  AI-generated content may be incorrect.]
            Figure 1-16. The Excel file generated by ChatGPT with the column chart. 

          

          With this simple example, you have seen one of ChatGPT’s two uses with Excel: automatic data analysis. The other type of use, which we will also see throughout the book, is as an assistant for suggesting formulas or procedures for data analysis.

          Having tried this exercise, I hope ChatGPT has not disappointed you, and that I have convinced you to continue reading this book. If you were faster than ChatGPT, it doesn’t mean that ChatGPT isn’t helpful to you, but rather that you already know Excel well, and the integration with AI will only further improve your skills, as we’ll see later in the book. For now, I guarantee you that using AI in Excel has benefits. Let’s look at them.

        

      

      
        The Benefits of Using AI in Excel

        You may think that you need to use AI as your substitute in the sense that it automatically carries out tasks for you. In reality, in any field in which you use AI, including Excel, AI is always an assistant that can help you carry out your tasks more efficiently and accurately, but it can never wholly replace you. The last word will always be yours, and your task will be to ensure that the AI ​​does not make gross errors, including hallucinations and biases, as we will see later in the book. 

        Note

          AI hallucinations happen when the AI generates fake information. Bias is when the AI produces unfair or one-sided results.

        

        In this book, I will talk about artificial intelligence, but not in the sense of an automatic process that completely replaces humans. We will not be getting into sci-fi robots that make autonomous decisions and ultimately destroy the universe. In this book, you will learn some strategies to use AI to augment your intelligence. 

        AI is nothing other than a significant part of human knowledge contained in a tool. Much of the human effort to understand how the world works is contained in a tool with impressive potential. This is fantastic and very powerful, but also risky. Therefore, the main benefit of using AI in Excel is not so much automating tasks and having the machine carry them out autonomously as it is to tap into a vast available knowledge base, which is mankind’s heritage. 

        Your task is to learn to use this treasure in the best ways possible, and I will try to help you with that throughout the book. It is, therefore, not a question of acquiring concepts to automate more or less complex tasks, but instead a question of developing a mentality that will allow you to think with AI. You will always be the protagonist of the choices and analyses. AI will be your faithful travel companion at your service, helping you speed up tasks and be as precise as possible.

        
          Evaluating AI Results

          To evaluate whether the AI is working well on your data, you can apply supervised learning of the AI without making errors. This involves testing the AI results on a subset of your data. Manually perform your calculations on some of the data using Excel and then repeat the same calculations using AI. Once you have consolidated the prompts for the AI and ensured that they respond correctly, let the AI perform the task on the entire dataset.

        

      

      
        When AI Is Not Useful in Excel

        AI is a potent tool. However, at least two cases indicate that its use is not yet mature (at least as of the writing of this book):

        
          	Large datasets

          	
            When working with large datasets, AI can encounter some difficulties regarding performance and accuracy. The analysis of large datasets requires many resources and computational capabilities. An AI model such as ChatGPT could not provide these resources to ordinary users. For this reason, if you still want to use AI with large datasets, split the dataset into small parts that AI can process. For example, you could filter out unnecessary columns or rows from a dataset and provide only the data you want to analyze as input to AI.

          

          	Low-quality data

          	
            If you provide incomplete, noisy, or poorly structured data as input to AI, the quality of results can negatively impact model performance, leading to incorrect predictions or distorted interpretations. AI will have difficulty providing valuable and accurate outputs if data is missing, duplicated, or contains systematic errors. This is the case to repeat the classic maxim garbage in, garbage out, which means you can’t extract a significant output from a bad input.

          

        

        Despite these limitations, AI’s potential continues to grow, and as technologies and infrastructure advance, improvements in these areas are expected.

      

      
        Browsing Among the Different AI Tools for Excel

        The introduction of AI into Excel has opened up new opportunities to simplify working with data, improve efficiency, and reduce human errors. In recent years, numerous add-ins have been developed that integrate AI directly into Excel, each with different characteristics to meet specific needs. Many of them may require a subscription. This section looks at some of the significant AI tools for Excel: 

        
          	
            Numerous.ai: Numerous.ai is an add-in that uses AI to make predictions, clean data, and generate new insights. It can summarize, categorize, classify, and cleanse data and texts. Numerous.ai defines a specific function called AI(), which you can use to prompt ChatGPT directly in your worksheet.

          

          	
            GPT for Excel: GPT for Excel is an add-in that uses AI for data cleaning and classification, text generation and summarization, and translations. It defines two main functions:

            
              	
                GPTINTERACT() takes as input instructions and the data to process.

              

              	
                GPTPREDICT() takes some input example data, outputs example data, and data to be processed.

              

            

          

          	
            AutoPilot: AutoPilot is an add-in that integrates different AI models in Excel, such as ChatGPT, Google Gemini, Anthropic Claude, and more. It allows you to automate repetitive tasks such as data cleansing, applying complex formulas, and generating graphs. 

          

          	
            PowerGPT: PowerGPT is an add-in that uses AI to answer questions from your data, decipher any formula with explanations in plain English, generate formulas, create SQL queries from simple descriptions, generate regular expressions, and so on. 

          

          	
            AI-aided Formula Editor: The AI-aided Formula Editor supports creating and optimizing complex formulas in Excel. It can also explain and format formulas. The command write to cell enables you to copy the generated formula into a cell quickly.

          

          	
            Sally Suite: Sally Suite is an add-in that uses AI to automate repetitive processes, create sheets, write functions, filter data, create or recommend charts, translate sheets, perform data analysis, and even help generate Python code. 

          

          	
            Ghost Writer: Ghost Writer is an add-in for generating sample data, translating sheets, writing prompts, generating formulas, and automating documentation. It is also available for Microsoft Word and PowerPoint, which can generate reports, write documents, create inline comments on your content, and more.

          

        

        The various add-ins are constantly updated, so new features that are not described in this book may become available. I always suggest you check each tool’s official page before installing it.

        Which tool(s) should you choose? It depends on your needs. This book does not use any specific add-ins (unless explicitly stated), but we will rely on ChatGPT in the first part and Copilot in the second part. I haven’t talked much about Copilot so far because It is not an add-in but a tool integrated with Excel. We will see this later in the book.

        Note

          I would like to end this chapter with a small side note. When I was little, like many children, I had an imaginary friend to whom I told all my facts and into whom I projected all my childhood fears, doubts, and uncertainties. Unfortunately, since many years have passed since my childhood, I no longer remember the name of this imaginary friend. Today, however, I can say that I have a new friend, not exactly imaginary, but almost: ChatGPT (or AI in general), with whom I can interact in various ways. In this book, we’ll see how to combine AI and Excel, but I’ve even read posts on social media from people who use AI as a therapist. Well, in this book we will not use ChatGPT and AI as a therapist, but you can think of AI as your new imaginary friend, which unlike the one from your childhood, responds to your requests and is of great help to you. All you need to do is discover the key to open the door to this new imaginary friend.

        

      

      
        Summary

        Our journey together to discover the use of AI in Excel has just begun. In this chapter, you’ve seen why it makes sense to use AI in Excel and went through a brief example demonstrating it. In the next chapter, you will learn how to use ChatGPT within your Excel sheets best.

        
          	
            Integrating AI into Excel simplifies data management, analysis, visualization, and more tasks, improving overall efficiency.

          

          	
            AI in Excel improves productivity and accuracy. AI allows you to perform tasks faster and more precisely. It also reduces human errors, ensuring more accurate and reliable results.

          

          	
            Despite its many benefits, AI is not yet fully mature when processing massive datasets without advanced computational resources. 

          

          	
            Even the most powerful AI algorithm only works with quality data. Incomplete or noisy data can lead to misleading predictions or biased analyses. 

          

          	
            AI in Excel should be seen as an assistant to improve performance, not a complete replacement for human work. You should supervise the results generated by the AI ​​to avoid errors. 

          

        

      

      
        Activity

        Solve the crossword puzzle in Figure 1-17. After completing it, you’ll read the name of the AI tool you’ll use in the next chapter. The solution is in Appendix A.

        
          [image: A crossword puzzle with numbers and a rectangular object  AI-generated content may be incorrect.]
          Figure 1-17. Crossword puzzle to reveal the tool you will use next

        

        
          Definitions:
        

        
          	
            The basic unit of a table, located at the intersection of a row and a column of the table, where you can enter data or formulas.

          

          	
            A sheet within a work file, organized into rows and columns, where data can be inserted, viewed, and manipulated.

          

          	
            An add-in for Excel providing the AI() function to prompt ChatGPT directly.

          

          	
            An add-in for Excel providing the GPTINTERACT() function, which takes as input instructions and the data to process.

          

          	
            A set of selected cells.

          

          	
            The built-in AI tool provided by Excel. You’ll use it in the second part of this book.

          

          	
            A section in the Ribbon that groups related commands in Excel.

          

        

      

    



      

Chapter 2. Getting Started with ChatGPT and Excel



A Note for Early Release Readers


With Early Release ebooks, you get books in their earliest form—the author’s raw and unedited content as they write—so you can take advantage of these technologies long before the official release of these titles.


This will be the 2nd chapter of the final book. Please note that the GitHub repo will be made active later on.


If you have comments about how we might improve the content and/or examples in this book, or if you notice missing material within this chapter, please reach out to the editor at ccollins@oreilly.com.




      In high school, I had to memorize trigonometry formulas by heart to solve math exercises. These were also quite complex formulas that contained sines and cosines, additions and subtractions, and so on. After a lot of work, I managed to learn them perfectly and was able to solve the trigonometry exercises perfectly. Periodically, however, I had to review the formulas aloud—otherwise, I would forget them. I was 17 at the time, and my brain was very trained. More than twenty years have passed since then, and I remember very little of those trigonometry formulas. Our brains tend to forget what we don’t use, especially if it involves mnemonic formulas.

      The same thing happens with all available Excel functions. It is impossible to remember all the functions that Excel makes available to carry out specific calculations. You may have a more or less general idea about the name of the function to use, but you often don’t remember the syntax or the specific name. ChatGPT can help you with this, as it can tell you not only which function to apply each time but also how to apply it.

      In this chapter, you’ll see how to use ChatGPT to generate the formula or function you need. You will see a strategy for communicating with ChatGPT to make it generate precisely the output you want: not something general but specific and valid for your dataset. When I talk about communicating, I mean the literal meaning of transmitting a message to someone. The goal is to ensure that ChatGPT understands what you are talking about, generating output as close as possible to what you want it to develop. So, it’s more like you want to communicate with ChatGPT. This communication strategy with ChatGPT involves organizing the conversation as a story, with its typical parts: the context, the main point, and the end. We will test this strategy for calculating essential Excel functions, such as calculation, logic, and text functions.

      In this chapter, you will learn more about:

      
        	
          Introducing ChatGPT for Excel

        

        	
          The structure of a conversation

        

        	
          Basic functions

        

      

      Let’s start with the first aspect: ChatGPT for Excel.

      
        Introducing ChatGPT for Excel

        There are two ways to combine ChatGPT and Excel, as shown in Figure 2-2.

        
          [image: A diagram of a computer program  AI-generated content may be incorrect.]
          Figure 2-1. The two possible uses of ChatGPT in Excel. 

        

        In the first case, you can use ChatGPT as a companion or external tutor: ask specific questions about your dataset, and ChatGPT will help you answer them. Once you have the answers, apply them to your Excel file. This working method is helpful if you need clarification about how to write formulas or which functions to use, or if you need help answering the questions your data contains. 

        The second way to use ChatGPT is as a direct editing tool. In this case, you load the file directly into ChatGPT and work directly inside ChatGPT. In the end, you download the file with the changes already made by ChatGPT. 

        Warning

          Remember that the suggestions provided by ChatGPT may not always be correct, so you should always check the suggestions or proceed iteratively to gradually achieve the desired result.

        

        Whether you use ChatGPT as an assistant or as a direct editor, your job is to communicate with ChatGPT so that it understands what you want to talk about and helps you respond best. You can communicate with ChatGPT in two ways, as shown in Figure 2-2.

        
          [image: A diagram of a single prompt  AI-generated content may be incorrect.]
          Figure 2-2. The two ways of communicating with ChatGPT. 

        

        A single prompt is a single input used to directly specify a request or question. It does not consider any previous context unless that context is made explicit in the prompt itself. For example: Explain the formula for calculating the mean in Excel.

        A conversation is a set of multiple prompts connected to each other. It is an interaction between the user and ChatGPT that considers the session’s previous context, allowing for a continuous and coherent dialogue. Furthermore, it enables you to refine or expand a previously provided answer or ask subsequent questions about the ongoing conversation. For example, you might start with Write the formula to calculate the average in Excel and then ask, Explain the formula.

        The rest of this chapter focuses on using ChatGPT as an external assistant and working in conversation mode. However, everything I say about conversations also applies to prompts. At this point, we are ready to see the structure of a conversation (or a single prompt).

      

      
        The Structure of a Conversation

        Imagine that ChatGPT is a real interlocutor to whom you must say something. One important way humanity has communicated since ancient times is through stories. A story is defined primarily by a plot. You can organize your ChatGPT conversation as a simple story, where you are the narrator and ChatGPT is your audience, as shown in Figure 2-3.
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          Figure 2-3. How to organize a conversation with ChatGPT in the form of a story. 

        

        Each story begins by describing the context, the set of all the information necessary to ensure that the story’s audience (in your case, ChatGPT) understands what you are talking about. Then you present your main point to ChatGPT, such as calculating a formula or a specific function. Finally, you can ask ChatGPT to format the result in a certain way or to tell you why it used a specific formula. 

        Let’s take a practical example to understand how to organize a conversation like a story. Suppose you have the dataset of Amazon Top 50 Bestselling Books 2009 - 2019 available on Kaggle under the CC0: Public Domain license. The dataset contains 550 books categorized into fiction and nonfiction. Table 2-1 shows an excerpt of the dataset.

        
          Table 2-1. An extract from the dataset: the Amazon Top 50 Bestselling Books 2009-2019 dataset.
          
            
              	Name
              	Author
              	User Rating
              	Reviews
              	Price
              	Year
              	Genre
            

          
          
            
              	
                10-Day Green Smoothie Cleanse

              
              	
                JJ Smith

              
              	
                4.7

              
              	
                17350

              
              	
                8

              
              	
                2016

              
              	
                Non Fiction

              
            

            
              	
                11/22/63: The Novel

              
              	
                Stephen King

              
              	
                4.6

              
              	
                2052

              
              	
                22

              
              	
                2011

              
              	
                Fiction

              
            

            
              	
                12 Rules for Life: An Antidote to Chaos

              
              	
                Jordan B. Peterson

              
              	
                4.7

              
              	
                18979

              
              	
                15

              
              	
                2018

              
              	
                Non Fiction

              
            

            
              	
                1984 (Signet Classics)

              
              	
                George Orwell

              
              	
                4.7

              
              	
                21424

              
              	
                6

              
              	
                2017

              
              	
                Fiction

              
            

            
              	
                5,000 Awesome Facts (About Everything!) (National Geographic Kids)

              
              	
                National Geographic Kids

              
              	
                4.8

              
              	
                7665

              
              	
                12

              
              	
                2019

              
              	
                Non Fiction

              
            

          
        

        The dataset contains the following columns:

        
          	
            Name: Name of the book

          

          	
            Author: The author of the book

          

          	
            User Rating: Amazon user rating. A number between 1 and 5

          

          	
            Reviews: Number of written reviews on Amazon

          

          	
            Price: The price of the book (as of 13/10/2020)

          

          	
            Year: The Year(s) it ranked on the bestsellers

          

          	
            Genre: Whether fiction or nonfiction.

          

        

        You can download the dataset directly from Kaggle in CSV format or from the book’s GitHub repository in XLSX format under 02/books.xlsx. In the latter case, the dataset is already formatted as an Excel table and named books. 

        Let’s imagine we want to ask ChatGPT how to calculate the average price across all books. We structure the prompt like a story: context, main point, and end. Let’s start with the context. 

        
          Setting the Context

          The context corresponds to a text that contains all the information ChatGPT needs to frame your dataset. The context defines the following:

          
            	
              The topic you are discussing

            

            	
              The structure of the dataset with column names

            

            	
              Guidelines on how to work in Excel, such as specifying the table name

            

          

          As an alternative to points 2 and 3, you can directly upload the Excel file to ChatGPT. However, I suggest passing the table structure and name if your file contains sensitive or large data.

          Tip

            ChatGPT, by default, uses your input and conversations to train and improve the AI ​​models on which ChatGPT is based. You can disable data sharing and make your data private by following these steps:

            
            	On the ChatGPT web page, click on your profile icon at the top right and then select Settings from the menu.

            	Inside the settings, look for the section Privacy and Data Settings and deactivate the option Data Sharing.

            	Be sure to save any changes if required.


            Turning this option off will prevent ChatGPT from using your data used to improve models. This way, you can upload your datasets to ChatGPT without the risk of sharing sensitive content inappropriately.

          

          In the case of the books dataset, organize the context into three parts. First, define the topic you are dealing with:

          Consider a dataset relating to the Amazon Top 50 Bestselling Books 2009 - 2019.

          Then specify the dataset structure with column names:

          The dataset has the following columns:   
Name - Name of the book
Author - The author of the book
User Rating - Amazon user rating. A number between 1 and 5
Reviews - Number of written reviews on Amazon
Price - The price of the book (as of 2020/10/13)
Year - The Year(s) it ranked on the bestsellers
Genre - Whether fiction or non-fiction.

          Finally, provide some guidelines on how to work in Excel with your dataset:

          Suppose you import this dataset into Excel in a table named books and the column names corresponding to the dataset columns.

          In total, the context prompt part should look like this:

          Consider a dataset relating to the Amazon Top 50 Bestselling Books 2009 - 2019. The dataset has the following columns:   
Name - Name of the book
Author - The author of the book
User Rating - Amazon user rating. A number between 1 and 5
Reviews - Number of written reviews on Amazon
Price - The price of the book (as of 2020/10/13)
Year - The Year(s) it ranked on the bestsellers
Genre - Whether fiction or non-fiction.
Suppose you import this dataset into Excel in a table named books and the column names corresponding to the dataset columns.

          This prompt is the first message of a more extended conversation, or you can aggregate it with the rest of the story, which we’ll see shortly, and build a single prompt. Point to the ChatGPT website and give it the previous context prompt as input. To open the ChatGPT page follow the steps described below:

          
            	
              Connect on https://chatgpt.com/, login, and start a new conversation. 

            

            	
              Copy the context prompt defined previously and check the result.

            

          

          ChatGPT will respond with suggestions on what operations or types of analysis you can perform using this dataset. Out of pure curiosity, I fed this prompt to ChatGPT five times, starting a new chat each time, and I noticed that ChatGPT more or less suggests always doing the same operations, even if applied to different dataset columns. Operations include calculation of statistics, filtering and sorting operations, analysis, and visualizations of specific data.

          Once you’ve defined the context, you can specify the main point of the prompt or conversation. We’ll explore this further in the next section.

        

        
          Defining the Main Point

          The story’s main point is the problem that ChatGPT needs to solve, or more generally, the question you want to ask ChatGPT. The structure of the main prompt comprises four main elements:

          
            	The action

            	
              This indicates the operation you want ChatGPT to perform. It’s formulated clearly and directly. It includes verbs that describe what you want to achieve (e.g., Write, Explain, Analyze).

            

            	Objective

            	
              This describes your request’s final result or purpose, that is, what you want to achieve through the action. It must be specific and linked to the problem to be solved or the task to be completed.

            

            	Additional details

            	
              These define additional information that has not been described in the context and should help ChatGPT to understand the request, such as available data, relevant parameters, or restrictions. This helps personalize the response by making it more appropriate.

            

            	The level of complexity

            	
              This specifies the necessary level of detail in the response, adapting it to the user experience. For example, it can be basic (for beginners) or advanced (for advanced users). 

            

          

          In some cases, as we will see shortly, you can omit some elements. For example, after defining the context as explained above, use this main point prompt to write the formula in Excel to calculate the average price of books by genre:

          
            	
              Action: Write 

            

            	
              Objective: the formula in Excel to calculate the average price of books.

            

            	
              Additional details: -

            

            	
              Level of complexity: - 

            

          

          Here is a possible output produced by ChatGPT (plus some explanatory text): 

          =AVERAGE(books[Price])
 
Explanation:
* books[Price]: Refers to the Price column in the table named books.
* AVERAGE: Calculates the mean value of the numbers in the Price column.

          As you can see, ChatGPT has generated a formula adapted to your dataset because it contains exactly the names of the books table and the columns (Genre and Price) that you previously set in the context. 

          Note

            ChatGPT returns the formula in English by default. However, if Excel, in your case, is set in another language, you should also indicate the language in which Excel is used for ChatGPT. For example, if you use the Italian version of Excel, you can write the following prompt: 

          
            Write the formula for the Italian version of Excel to calculate the average price of books.

        
            In this case, the generated formula is: =MEDIA(books[Price]).

          

          You can adapt the prompt structure based on your use of ChatGPT. Generally, you can structure a main point prompt differently based on the different uses of ChatGPT, as shown in Figure 2-4.
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            Figure 2-4. The roles ChatGPT can play in helping you answer your questions. 

          

          
            	
              As an assistant, ChatGPT can guide you through using Excel, helping you understand how to create formulas, use functions, or customize spreadsheets to fit your needs. For example, you could ask ChatGPT: Write the formula in Excel to calculate the average price of books by genre. 

            

            	
              As a teacher, ChatGPT can clarify complex Excel concepts, such as macros, pivot tables, and data analysis, making them more understandable. For example, you could ask ChatGPT how pivot tables work to analyze the total number of reviews for each year in the dataset. 

            

            	
              As an analyst, ChatGPT supports you in interpreting data, suggesting ways to visualize information through graphs, or identifying trends and patterns. For example, you might ask: What are the five books with the highest average rating, considering only fiction books? 

            

            	
              For troubleshooting, ChatGPT can help you fix common problems in Excel, such as formula errors, formatting problems, or difficulties importing data. For example, you could ask: What is the error in this [formula]? 

            

          

          Throughout the book, we will see how to define the various questions based on the task you must carry out in Excel. For now, it’s enough to know that there are four types of main points. 

          The main prompt’s contents change depending on the ChatGPT role, as described in Table 2-2.

          
            Table 2-2. The contents of the main prompt based on the ChatGPT role.
            
              
                	Role
                	Action
                	Objective
                	Additional Details
                	Level of Complexity 
                	Example
              

            
            
              
                	
                  Assistant

                
                	
                  Clear and direct request.

                  Verbs: Write, Create, Show, Calculate, Define

                
                	
                  Get a formula or function to complete a specific task.

                
                	
                  Specific context, such as columns or functions.

                
                	
                  Not required.

                
                	
                  Write a formula to calculate the average price by genre. 

                
              

              
                	
                  Teacher

                
                	
                  Request a detailed explanation or step-by-step guide.

                  Verbs: Explain, Show, Describe, Guide, Illustrate

                
                	
                  Understanding a complex concept or learning to use a function.

                
                	
                  Add a practical example or data relevant to the concept explained

                
                	
                  Specify the level: beginners or advanced.

                
                	
                  Give me a simple example of how pivot tables work to analyze the total number of reviews for each year.

                
              

              
                	
                  Analyst

                
                	
                  Request analysis or visualization suggestions.

                  Verbs: Analyze, Suggest, Identify, Visualize

                
                	
                  Extract meaningful trends, patterns, or insights from your data.

                
                	
                  Specific context, such as columns.

                
                	
                  Not required, but it may be helpful to specify the chart type.

                
                	
                  Analyze the five books with the highest average rating in the ‘fiction’ genre. Suggest a graph to visualize the results.

                
              

              
                	
                  Troubleshooting

                
                	
                  Request for assistance to resolve a specific problem.

                  Verbs: Solve, Correct, Identify, Help, Explain

                
                	
                  Request for assistance to resolve a specific problem.

                
                	
                  Provide details such as the formula or context of the problem.

                
                	
                  Not required.

                
                	
                  I’m trying to add the prices of books with the ‘Fiction’ genre using the formula =SUM(IF(A1:A10=\"Fiction\", B1:B10)), but it returns an error. Can you help me understand the error and fix it?

                
              

            
          

          The table shows a structured guide for defining prompts for use with ChatGPT based on four main roles: Assistant, Teacher, Analyst, and Troubleshooting. For each role type, the table shows the structure of the main point prompt and an example of its use.

          Once you have defined the prompt’s main point, you can proceed to its final part, which corresponds to the end of the story.

        

        
          Setting the End

          The end of the story tells ChatGPT what to do after performing the main task. You have three main options. You can ask ChatGPT the following:

          
            	
              What steps are required to generate the response in Excel? For example, if we ask ChatGPT to create a formula, we can now ask what the steps are to insert it into Excel. 

            

            	
              List alternative solutions. 

            

            	
              Calculate the answer to the question directly in an Excel file to export as output. You can only use this solution if you initially loaded the Excel file containing the entire dataset or a portion of it. 

            

          

          Returning to our example prompt, we can ask ChatGPT to list the steps for entering the formula into Excel using the following prompt (always within the same conversation that contains the context and main point):

          List the steps to include the proposed formula in Excel.

          ChatGPT generates a detailed list of steps. Here, I report only the top-level steps:

          Step 1: Open the Dataset
Step 2: Convert Data to a Table (Optional)
Step 3: Select a Cell for the Formula
Step 4: Enter the Formula
Step 5: Verify the Result
Optional: Format the Result
Step 6: Save the File

          At this point, you have learned how to communicate with ChatGPT. Organize your conversation like a story: context, main point, and end. You can structure your chat as a single prompt to feed to ChatGPT or as three separate prompts within the same conversation: one for the context, one for the main point, and one for the end. 

          Tip

            I suggest using three separate prompts in the same conversation so you can reuse the same context for multiple questions or main points.

          

          So far, we have seen the generic structure of a prompt in ChatGPT. The more knowledge you have about the problem you want to solve, the better the results that will be produced. The next exercise looks at a practical example to see how best to structure prompts. 

        

      

      
        Exercise: Structuring Prompts

        Consider again the dataset on Amazon Top 50 Bestselling Books 2009 - 2019. Start a new conversation with ChatGPT and write the following context prompt (defined above): 

        Consider a dataset relating to the Amazon Top 50 Bestselling Books 2009 - 2019. The dataset has the following columns:   
Name - Name of the book
Author - The author of the book
User Rating - Amazon user rating. A number between 1 and 5
Reviews - Number of written reviews on Amazon
Price - The price of the book (as of 2020/10/13)
Year - The Year(s) it ranked on the bestsellers
Genre - Whether fiction or non-fiction.
Suppose you import this dataset into Excel in a table named books and the column names corresponding to the dataset columns.

        Then write the main point prompt for each of these tasks:

        
          	
            Task 1: Calculate the highest price

          

          	
            Task 2: Explain how to create a pivot table to analyze the total sum of reviews for each year and sort the results in ascending or descending order.

          

          	
            Task 3: Find the error in this formula: =AVERAGEIF(books[User Rating]>4.5, books[Price])).

          

        

        Let’s proceed with the resolution of the exercise, starting with the first task.

        
          Task 1

          Use ChatGPT as an assistant and write the following prompt:

          Write the formula in Excel to calculate the highest price of books. Use the Price column from the books table.

          ChatGPT should respond with the following output:

          To calculate the highest price of books in the Price column from the books table, use the following formula in Excel:
=MAX(books[Price])
Explanation:
books is the name of the table.
[Price] refers to the column named Price within the books table.
MAX is the function that returns the highest value in the specified range.
Place this formula in any cell, and it will display the maximum price of the books in the table.

          By pasting the formula suggested by ChatGPT into the Excel sheet, we get the result shown in Figure 2-5.

          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 2-5. Figures 2-5. The result of Task 1. 

          

        

        
          Task 2

          Use ChatGPT as a teacher and write the following prompt:

          Explain how to create a Pivot Table in Excel to analyze the total sum of reviews for each year and sort the results in ascending or descending order. Use the Reviews column as the values and the Year column as rows. Use a base level of complexity.

          In my case, ChatGPT produced the following output, with a simple explanation of the steps to follow to create the required Pivot Table:

          Here is a step-by-step guide to creating a Pivot Table in Excel to analyze the total sum of reviews for each year, using the Reviews column as values and the Year column as rows:
Step 1: Select Your Data
Click anywhere inside the books table to ensure all columns (Year, Reviews, etc.) are recognized.
Go to the Insert tab on the Ribbon and click PivotTable.
Step 2: Set Up the Pivot Table
In the Create PivotTable dialog:
Ensure the correct table or range (books) is selected.
Choose where to place the Pivot Table:
Select New Worksheet (recommended) or Existing Worksheet.
Click OK.
Step 3: Add Fields to the Pivot Table
In the PivotTable Fields there are:
Drag the Year field to the Rows area. This will list all the years in the rows of the Pivot Table.
Drag the Reviews field to the Values area. By default, Excel will sum the Reviews.
Step 4: Sort the Results
Click the dropdown arrow in the Row Labels section of the Pivot Table.
Choose Sort by... and select either Smallest to Largest or Largest to Smallest to sort the total reviews by year in ascending or descending order.
Step 5: Optional - Format and Analyze
If desired, format the numbers in the Pivot Table:
Right-click any number in the Sum of Reviews column.
Select Number Format and choose a format like Number (with thousands separators) for clarity.
Review the table to see the total reviews for each year sorted as specified.

          If you follow the instructions provided by ChatGPT step by step, you should get the table shown in Figure 2-6.

          
            [image: A screenshot of a spreadsheet  AI-generated content may be incorrect.]
            Figure 2-6. Figures 2-6. The Pivot Table produced as a result of Task 2. 

          

        

        
          Task 3

          Use ChatGPT to troubleshoot and write the following prompt:

          Find and explain the error in the provided formula and suggest the correct version to calculate the average price of books with a user rating higher than 4.5: =AVERAGEIF(books[User Rating]>4.5, books[Price]))

          ChatGPT responds by explaining that the formula contains several errors. After explaining the correct syntax of the AVERAGEIF function, it provides the correct formula:

          =AVERAGEIF(books[User Rating], ">4.5", books[Price])

          Paste the formula into an Excel cell to obtain the result shown in Figure 2-7.

          
            [image: A screenshot of a spreadsheet  AI-generated content may be incorrect.]
            Figure 2-7. Figures 2-7. The result of Task 3. 

          

          Warning

            If your computer uses a comma (,) as a decimal separator instead of a period (.), the provided formula may return an error or unexpected results. This is because Excel interprets numeric values ​​differently depending on your system locale. 

            To solve the problem, you can change the general settings of your computer, or you can adapt the formula to the local decimal point. For example, if you use a comma as a decimal separator, write the formula as follows: 

            =AVERAGEIF(books[User Rating]; ">4,5"; books[Price])

            Note that the period in the value 4.5 is replaced with the comma 4,5, and the argument separator changes from “,” to “;”.

            
              Challenge: What information must you add to the prompt context so that ChatGPT automatically generates the formula using your local decimal point?
            

          

          Now that we have consolidated the conversation structure with ChatGPT, let’s examine the concept of formulas and functions in Excel and see how we can use ChatGPT to speed up their creation.

        

      

      
        Basic Functions and Formulas

        I have always been passionate about mathematics, particularly the study of functions and formulas. I remember with pleasure that when I was in high school, my mathematics teacher explicitly prevented me from answering the questions she asked the class about which function to use in a certain situation because she knew I already knew the answer. My passion for functions and formulas has spanned the years, and I have carried it to this day. 

        There is a fundamental difference between the concept of function and formula:

        
          	
            Functions are predefined operations that simplify complex or repetitive calculations, such as adding numbers, calculating averages, or searching for specific values ​​(for example, SUM, AVERAGE).

          

          	
            Formulas are user-defined expressions that perform calculations or manipulations on data. They always start with an equal sign (=) and can combine operators, constants, and references (such as =A1+A2).

          

        

        This section discusses the main types of functions with practical examples using the books dataset. You will also see how ChatGPT can help you use these functions to build basic formulas. 

        You can group the functions provided by Excel into the following six macro-categories:

        
          	
            Calculation: Perform mathematical operations like average, sum, maximum, and minimum

          

          	
            Counting: Count cells, values, or specific conditions

          

          	
            Logical: Evaluate conditions or perform actions based on conditions

          

          	
            Search: Find specific values or positions within data

          

          	
            Text Manipulation: Modify or analyze text strings

          

          	
            Date and Time: Handle operations involving dates and times.

          

        

        Let’s examine each group of functions individually and consider how ChatGPT can help you define them faster based on your data.

        
          Calculation

          Use the calculation functions to perform basic mathematical and statistical operations, such as adding, averaging, rounding, or finding the maximum and minimum value in a set of data. Examples:

          
            	
              =SUM(A1:A10): Calculates the sum of the values ​​in cells A1 to A10.

            

            	
              =AVERAGE(A1:A10): Calculates the average values ​​in a range.

            

            	
              =MAX(A1:A10): Returns the maximum value in a range.

            

            	
              =ROUND(A1, 2): Rounds the value in A1 to two decimal places.

            

          

          You can use ChatGPT as an assistant to generate the right formula for your data. Start the conversation with ChatGPT by defining the context as described above and then define the main point as follows:

          
            	
              Action: Write 

            

            	
              Objective: the formula in Excel to calculate [calculation function] [column].

            

            	
              Additional Details: Use the table [table name].

            

            	
              Level of complexity: - 

            

          

          For example, if you want to calculate the total sum of all reviews in the books table, use the following prompt:

          Write the formula in Excel to calculate the sum of Reviews. Use the table books.

          ChatGPT responds by indicating the following formula:

          =SUM(books[Reviews])

        

        
          Exercise

          After defining the context for the books table, write the prompt for the following tasks:

          1. Calculate the average of the reviews in the books table
2. Calculate the sum of the prices of all the books
3. Calculate the average price of books in the "Fiction" genre.
4. Identify the highest price among books in the "Non-Fiction" genre.
5. Calculate the minimum price of books in the "Non-Fiction" genre.

          Test every output produced by ChatGPT in Excel.

        

        
          Counting

          Use the counting functions to count cells based on certain criteria, such as counting non-blank cells, counting cells that meet a specific condition, or multiple criteria at once. Examples:

          
            	
              =COUNTA(A1:A10): Count all non-blank cells.

            

            	
              =COUNTIF(A1:A10, ">5"): Count cells with values ​​greater than 5.

            

            	
              =COUNTIFS(A1:A10, ">5", B1:B10, "Fiction"): Count cells that match multiple criteria.

            

          

          You can use ChatGPT as an assistant to generate the right formula for your data. Start the conversation with ChatGPT by defining the context as described above and then define the main point as follows:

          
            	
              Action: Write 

            

            	
              Objective: the formula in Excel to count cells [criterium].

            

            	
              Additional details: Use the table [table name].

            

            	
              Level of complexity: - 

            

          

          For example, if you want to count all books with reviews greater than 4, write the following prompt:

          Write the formula in Excel to count cells with review > 4. Use the table books.

          ChatGPT generates the following output:

          =COUNTIF(books[Reviews], ">4")

        

        
          Exercise

          After defining the context for the books table, write the prompt for the following tasks:

          
            	
              Determine how many books belong to the “Fiction” genre

            

            	
              Count the number of books that have a price of 0

            

            	
              Check how many books have received more than 1000 reviews

            

            	
              Count how many times the author “J.K. Rowling” appears in the Author column

            

            	
              Counts the total number of books in the table, regardless of specific values.

            

          

          Test every output produced by ChatGPT in Excel.

        

        
          Logical

          Use the logical functions to perform conditional operations returning different results based on true or false conditions. Examples:

          
            	
              =IF(A1>10, "High", "Low"): Returns “High” if A1 is greater than 10, otherwise “Low”.

            

            	
              =AND(A1>10, B1<5): Returns TRUE if both conditions are satisfied.

            

            	
              =OR(A1>10, B1<5): Returns TRUE if at least one of the conditions is satisfied.

            

          

        

        
          Search

          Use the search functions to find specific values ​​within a range of data. Examples:

          
            	
              =VLOOKUP(1001, A1:D10, 3, FALSE): Looks for the value “1001” in the first column and returns the value of the third column.

            

            	
              =INDEX(A1:A10, 5): Returns the value in the fifth row of the range.

            

            	
              =MATCH(50, A1:A10, 0): Find the position of the value “50” in the range.

            

          

          You can use ChatGPT as an assistant to generate the right formula for your data. Start the conversation with ChatGPT by defining the context as described above and then define the main point as follows:

          
            	
              Action: Write 

            

            	
              Objective: the formula in Excel to search [criterium].

            

            	
              Additional details: Use the table [table name]. 

            

            	
              Level of complexity: - 

            

          

          For example, if you want to find the genre of the book 10-Day Green Smoothie Cleanse, write the following prompt:

          Write the formula in Excel to search the Genre for the book “10-Day Green Smoothie Cleanse”. Use the table books.

          ChatGPT generates the following output:

          =VLOOKUP("10-Day Green Smoothie Cleanse", books, 7, FALSE)
Explanation:
"10-Day Green Smoothie Cleanse": The value you are searching for in the first column of the books table.
books: The name of the table.
7: The column index for Genre in the books table (assuming Genre is the 7th column).
FALSE: Ensures an exact match.

        

        
          Exercise

          After defining the context for the books table, write the prompt for the following tasks:

          
            	
              Find the author of the book The Hunger Games

            

            	
              Find the genre of the book with the maximum price

            

            	
              Find the price of the book The Great Gatsby

            

            	
              Find the year of the book with the maximum number of reviews

            

            	
              Find the name of the book at the lowest price.

            

          

          Test every output produced by ChatGPT in Excel.

        

        
          Text Manipulation

          Use text formulas to manipulate and manage text strings. They allow you to merge text, extract specific characters, and determine the length of a string, improving the processing of textual data. Examples:

          
            	
              =CONCAT(A1, B1): Combine the text in cells A1 and B1.

            

            	
              =LEFT(A1, 5): Extracts the first 5 characters of the text in A1.

            

            	
              =ONLY(A1): Returns the length of the text in A1.

            

          

          You can use ChatGPT as an assistant to generate the right formula for your data. Start the conversation with ChatGPT by defining the context as described above and then define the main point as follows:

          
            	
              Action: Write 

            

            	
              Objective: the formula in Excel to [text manipulation] [involved columns].

            

            	
              Additional details: Use the table [table name].

            

            	
              Level of complexity: - 

            

          

          For example, if you want to extract the first name of each author, write the following prompt:

          Write the formula in Excel to extract each author’s first name in the Author column. Use the table books.

          ChatGPT generates the following output:

          =LEFT(books[@Author], FIND(" ", books[@Author]) - 1)
Explanation:
books[@Author]: Refers to the current row's value in the Author column of the books table.
FIND(" ", books[@Author]): Finds the position of the first space in the author's name.
LEFT(books[@Author], FIND(" ", books[@Author]) - 1): Extracts all characters from the start of the name up to (but not including) the first space, giving the first name.

        

        
          Exercise

          After defining the context for the books table, write the prompt for the following tasks:

          
            	
              Remove extra spaces from a title

            

            	
              Extract the last name of the author

            

            	
              Transform the title to lowercase

            

            	
              Combine the book title and author

            

            	
              Find the length of a book title.

            

          

          Test every output produced by ChatGPT in Excel.

        

        
          Date and Time

          Use date and time formulas to work with dates and times, allowing you to get the current date and time or extract specific parts of a date. Examples:

          
            	
              =TODAY(): Returns the current date.

            

            	
              =YEAR(A1): Extracts the year from a date.

            

            	
              =DATEDIF(A1, B1, "d"): Calculate the difference between two dates in days.

            

          

          You can use ChatGPT as an assistant to generate the right formula for your data. Start the conversation with ChatGPT by defining the context as described above and then define the main point as follows:

          
            	
              Action: Write 

            

            	
              Objective: the formula in Excel to calculate [date operation].

            

            	
              Additional Details: Use the table [table name].

            

            	
              Level of complexity: - 

            

          

          For example, if you want to extract the year from today’s date, write the following prompt:

          Write the formula in Excel to calculate the year from today’s date. Use the table books.

          ChatGPT generates the following output:

          =YEAR(TODAY())

        

        
          Exercise

          After defining the context for the books table, write the prompt for the following tasks:

          
            	
              Calculate the number of years that have passed since a book was published

            

            	
              Find books published in the last 5 years

            

            	
              Calculate the difference in days between today and a book year

            

            	
              Calculate the age of a book in months

            

            	
              Check if a book was published in a leap year

            

          

          Test every output produced by ChatGPT in Excel.

          
            The Forest for the Trees

            At the beginning of the chapter I told you about my passion for mathematics since I was a child. Over the years, to this passion I have added a passion for data and everything it represents. When you start loving data, you’ll see it everywhere. Just a few days ago, during a car trip, I was sitting in the passenger seat, and my husband was driving. As the car rolled along the highway, I admired the passing landscape. At a certain point, something strange appeared: a hill with trees lined up and arranged in order. And I noticed how similar those trees were to the rows and columns of a table. 

            To immortalize the moment, I took the photo shown in Figure 2-8.

          
          
            [image: A green hill with trees and blue sky  AI-generated content may be incorrect.]
            Figure 2-8. The photo I took during my trip. 

          

          
            Out of curiosity, after arriving at my destination, I gave Figure 2-8 as input to ChatGPT and asked it to extract the number of rows and columns of trees, organize them in the form of a table, and format them as an Excel file. I used this prompt: 

            
              Consider the attached picture containing trees organized in rows and columns. Build a table with as many rows and columns as the number of tree rows and columns in the picture. Format the resulting table as an Excel Table downloadable as an XLSX file.

              The result was amazing. ChatGPT counted 20 tree columns and 10 tree rows and organized them into an Excel file, as shown in Figure 2-9. 

        
          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 2-9. The table built by ChatGPT based on the picture shown in Figure 2-8. 

          

          
            Counting the rows and columns by hand, I deduced that there are exactly 20 columns and about 10 rows. I say about because it’s difficult to extract the exact number of rows. However, the result provided by ChatGPT was impressive. 

            From this example you can see the potential of ChatGPT, which can extract tables even from images. And it is precisely this, as well as other concepts, that we will deal with in the next chapter.

          

        

      

      
        Summary

        We have reached the end of this chapter, and you have now seen some basic strategies for using ChatGPT to generate appropriate prompts for your dataset. In the next chapter, you will learn how to speed up common operations in ChatGPT.

        
          	
            ChatGPT can simplify complex tasks like generating functions, guiding data analysis, and resolving errors efficiently. 

          

          	
            Prompts are organized as narratives with three key parts: 

            
              	
                Context: Define the dataset and requirements. 

              

              	
                Main Point: Specify the task or question. 

              

              	
                Conclusion: Outline the desired outcome or next steps.

              

            

          

          	
            ChatGPT can play four different roles while assisting you: 

            
              	
                Assistant: Generate formulas and solve specific tasks.

              

              	
                Teacher: Explain complex concepts and guide step-by-step processes.

              

              	
                Analyst: Identify patterns, trends, and insights in data.

              

              	
                Troubleshooter: Diagnose and correct formula errors or functionality issues.

              

            

          

          	
            Excel essential functions can be grouped into six categories: calculation, counting, logical, search, text manipulation, and date and time.

          

          	
            ChatGPT can help you to build customized formulas for your specific dataset. 

          

        

      

      
        Activity

        Complete the following text using the keywords indicated below. The solution is in Appendix A.

        ASSISTANT - CALCULATION - CHATGPT - CONTEXT - END - MAIN POINT - PROMPT - VLOOKUP

        In this chapter, you learned how to structure an effective __________ to best use __________ in Excel, organizing it into three fundamental parts: context, main point, and end. The __________defines the data and information necessary to frame the problem, the__________ describes the action required, while the __________indicates how to use the result.

        ChatGPT can be used as an__________ to perform various tasks, such as generating formulas for __________ (for example, summing or averaging) or performing search operations with functions like __________. This combination of strategies helps you improve productivity, automate complex calculations, and quickly resolve problems in your datasets.

      

    



      Chapter 3. Speeding Up Common Operations with ChatGPT

      
      
A Note for Early Release Readers


With Early Release ebooks, you get books in their earliest form—the author’s raw and unedited content as they write—so you can take advantage of these technologies long before the official release of these titles.


This will be the 3rd chapter of the final book. Please note that the GitHub repo will be made active later on.


If you have comments about how we might improve the content and/or examples in this book, or if you notice missing material within this chapter, please reach out to the editor at ccollins@oreilly.com.



      Everyone has to deal with some tedious, time-consuming, and repetitive tasks. One of these for me is making the bed every morning, not only mine (and my husband’s) but also my children’s. You must do it for the decorum of the house, but it’s very dull, takes time, and is repetitive. To solve the problem, I could hire a housekeeper and ask them to arrange the beds for me. This is a bit like what ChatGPT does in the digital world. You can request it to become your housekeeper, and to carry out tedious and repetitive tasks for you. If there were a ChatGPT that could make beds, I would definitely buy it (of course, only at a reasonable cost).

      Similarly, when you use Excel, you often have to deal with tedious, time-consuming, and repetitive tasks. You want to speed them up as much as possible. These include, for example, the creation of templates, filling tables with patterns defined as dates or progressive numbers, and even enriching a dataset with values ​​external to the dataset. Well, ChatGPT can be your housekeeper. 

      In Chapter 2, you saw that ChatGPT can be a companion in your activities, an assistant, or a secretary—call it what you want. The concept is that ChatGPT assists you while carrying out your tasks. In this chapter, you will use ChatGPT in a new way, as a housekeeper, to carry out tedious, repetitive, and time-consuming tasks for you. 

      This chapter covers the following topics using ChatGPT:

      
        	
          Creating templates

        

        	
          Autofill

        

        	
          Data enrichment

        

      

      Let’s start with creating templates.

      
        Creating Templates

        A template in Excel is a predefined file with a ready-made structure and format for specific tasks, such as budget management or inventory. Usually, a template contains pre-configured tables, formulas, and graphs. When I think of a template in Excel, I refer to the templates I see when creating a new workbook, such as budget planners and homework logs. You can make your personal templates by creating an Excel workbook with the layout, formatting, and formulas you want, saving it as an Excel Template, and putting it in the appropriate folder. Once you’ve created the template, you can use it to create new workbooks based on it, so you don’t have to reinvent the wheel every time.

        Using a template offers several advantages, such as saving time, achieving consistency in format and style between different documents, and reducing errors. In essence, a template can speed up repetitive tasks such as creating reports, invoices, or calendars by including predefined layouts, formatting, and formulas.

        To create your template in ChatGPT, write a prompt with the story structure you learned about in Chapter 2: context, main point, and end. There are two application cases: 

        
          	
            Create the template from scratch, providing ChatGPT with all the details

          

          	
            Create the template from a (handwritten) sketch, which you provide to ChatGPT as input.

          

        

        Let’s analyze both cases, starting with creating the template from scratch.

        
          Creating Templates from Scratch

          When you create a template from scratch, you must provide ChatGPT with all the necessary information. Start a conversation with ChatGPT by following the flow described in Figure 3-1. 

          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 3-1. The flow to follow to generate an Excel template using ChatGPT.

          

          The prompt follows the story structure, where the final stage of the story is the creation of the Excel file, already included in the context prompt:

          
            	
              After logging in to https://chatgpt.com, start a new conversation, defining the context, which contains the fact that you want to create a template:

            
          I want to create an Excel template. I'll provide you with all the options to include in the template, and when I have finished, you'll format it as an .xlsx file. 


            	
              Specify the structure of the workbook, such as the number of worksheets, the number of tables, and the structure of the tables with columns. For example, you can create a single worksheet containing a single table using the following prompt:

            
          Create a single worksheet containing a table with the following columns: 
- Date 
- Category 
- Description 
- Amount 
- Payment Method 
Format the table as an Excel table and name it MainTable. 
Add 10 empty rows to the table.

          At this point, ChatGPT has generated a file in .xlsx format, which you can download. Next, open the file. Figure 3-2 shows the result.

          
            
            Figure 3-2. The Excel file generated by ChatGPT after the second step.

          


            	
              Define how to format the data, as shown in the following prompt:

            
          Format cells Number as follows:  
- Column A as a date (YYYY/MM/DD) 
- Column B as text
- Column C as text
- Column D as currency with symbol $
- Column E as text

          Download the file generated by ChatGPT. To test the formatting correctness, enter the following information in the first row of the table:

          2025-01-08, MyCategory, MyDescription, 3, Cash

          The date refers to 2025, 8th January. Excel automatically formats the date and amount, as Figure 3-3 shows. Once you have tested the formatting correctness, you can delete the content of the first row.

          
            
            Figure 3-3. The Excel file generated by ChatGPT after data validation.

          


            	
              Add more details to the worksheet. For example, you can add a formula that automatically totals the Amount field, as shown in the following prompt:

            
          Add a row below Amount and out of the table for total Expenses, calculated as the sum of all the Amounts.

          Figure 3-4 shows the Excel file generated by ChatGPT.

          Note

            This method calculates a total value using a cell formula. The goal of this example was to show that you can use ChatGPT to insert formulas outside of tables and enhance your worksheet with various formulas. Alternatively, you can use the Total Row feature, which is available for Excel tables.

            Go to Table Design and check the box for Total Row. Excel will add a row at the bottom of the table with built-in functions. You can click on the cells in the total row to choose other functions from a drop-down menu, such as Sum, Average, Count, and more.

          

          
            
            Figure 3-4. The Excel file generated by ChatGPT after adding a formula to the worksheet.

          


            	
              At this point, you can apply a style, defining colors, borders, and so on. For example, you can use the following prompt:

            
          Apply the following style to the table MainTable:

First row:
- Set the text to bold
- Set the text color to black
- Set the background color to light grey
- Align text to the center

Other rows:
- Align text to the left for text columns and right for numeric columns
- Set the background color to white for all the cells starting from the second row

Borders:
- Apply thin black borders

          Figure 3-5 shows the file generated by ChatGPT after applying the style.

          
            
            Figure 3-5. The Excel file generated by ChatGPT after applying your style.

          

          


          Warning

            In some cases, ChatGPT may not generate the correct template. This is because the models behind ChatGPT are not perfect. To resolve this issue, apply one of the following suggestions:

            
              	
                Rerun the exact same prompt several times until you get the desired result. For example, you can use the prompt: “Please try again”.

              

              	
                Change the prompt slightly

              

              	
                If you lose the cell’s formatting, rerun the prompt, asking ChatGPT to apply specific formatting.

              

            

          

        

        
          Exercise 1

          Write prompts for ChatGPT to generate the table in Figure 3-6. Format the ISBN field as XXX-X-XXXXX-XXX-X, and the calculation of Total Books as the count of all the books in the table.

          
            
            Figure 3-6. The table to generate using ChatGPT.

          

          You can find the solution containing the prompt in the book’s GitHub repository as 03/exercise1_solution.txt.

          So far, you have seen how to organize a conversation with ChatGPT step by step so that it generates the desired output. You’ve probably noticed how tiring it is to follow the conversation with ChatGPT. It would be great if you could give all the conversation prompts in one go and then let ChatGPT digest them gradually. Well, I have some good news for you. This is possible, which is exactly what we will see in the next section.

        

        
          Automatically Generating a Template from Scratch

          To automatically generate a template from scratch, write all the prompts in a single file, and then feed the file to ChatGPT. The only care you need to take is to define an opening prompt accompanying the file loaded into ChatGPT. The opening prompt specifies exactly how ChatGPT should behave when executing the instructions contained in the file. 

          For example, you can define the following opening prompt:

          Open the attached file and identify the first instruction, which begins with the keyword [STEP].

Carefully read the first instruction and follow the steps exactly as described.
Complete the first instruction fully before moving on to the next.
After completing the first instruction, move on to the next one and repeat the process, following the sequence strictly.

Ensure that each instruction is executed separately without combining or skipping steps.
If you encounter an unclear instruction or one that cannot be executed, stop the process.
Provide a detailed explanation of the issue.

Once all instructions are completed, ensure the following:
- Every request has been implemented as specified.
- All required formatting and styles are properly applied.

After completing all steps, confirm that the process has been successfully executed.
Share the generated file for review.

Execute each instruction as a separate unit, without skipping or combining multiple instructions.
Follow a clear and logical sequence, ensuring each step is completed before moving on to the next.

          Attach to the opening prompt the template_instructions.txt file formatted as follows:

          [STEP] Prompt 1

[STEP] Prompt 2

[STEP] Prompt N

          You can test this technique directly using the file found in the book’s GitHub repository, as 03/template_instructions.txt. This file contains the instructions described in the “Creating Templates from Scratch” section, preceded by the keyword [STEP], as shown in the following prompt:

          [STEP] I want to create an Excel template. I'll provide you with all the options to include in the template, and when I have finished, you'll format it as an .xlsx file. 

[STEP] Create a single worksheet containing a table with the following columns: 
- Date 
- Category 
- Description 
- Amount 
- Payment Method 
Format the columns as an Excel table and assign the name "MainTable". Add 10 empty rows to the table.

[STEP] ...

          Using this technique can be time-consuming for ChatGPT, so don’t worry if ChatGPT doesn’t provide the answer immediately.

          Tip

            Applying this technique, I’ve noticed that in most cases, ChatGPT fails to correctly format the table as an Excel table (despite it being explicitly asked in the instructions), soso if this happens, manually pass it the following prompt after it has executed all the prompts contained in the template:

            Format the generated table as an Excel Table.

            After this statement, ChatGPT formats the table correctly.

          

          
            ChatGPT as a friend

            I have tested this automatic technique many times with different templates and almost always obtained the same result: the tables were not formatted as Excel tables. Only after one or two trials did ChatGPT format the file correctly. I racked my brain, trying to understand why this happened. I changed the order of the prompts and the prompt text, but the result was still the same. Until I had a flash of genius, or as Gary Klein calls it in one of his books, creative desperation: I asked ChatGPT why it didn’t consider the instruction I had passed on to it. The response was shocking, beyond all expectations.

            I gave it this prompt as input:

            Explain why you didn't apply the format the table as an Excel table and name it MainTable

            ChatGPT gave me the following response:

            I did not apply the instruction to format the table as an Excel table and name it MainTable for the following technical reasons:

Difference between cell ranges and Excel tables: Although the data has been formatted as a range of cells with proper borders and styles, the specific Excel table format which includes features such as automatic filtering, dynamic rows, and the table name.

Library used (openpyxl): In Python, the openpyxl library supports the creation of formatted tables (also called "Tables" in Excel), but the process requires specific configuration which has not been done. I should have used the openpyxl.worksheet.table.Table method to convert the range to a table and name it MainTable.

If you want, I can immediately correct this and update the file with the correctly formatted table and the requested name. Let me know!

            Aside from the first answer, which might seem bizarre, the second answer explains the technique ChatGPT uses to generate Excel files. In practice, ChatGPT transforms the prompts into Python code (Python is a programming language) and executes the code using the openpyxl library, which is precisely the Python library for generating Excel files. Anyway, the performance and the quality of results depend on the chosen model. The Python library used for generating Excel files may depend on the model. Some models use the XlsxWriter Python library, and others use the openpyxl library.

          

        

        
          Creating Templates from Sketches

          At the end of chapter 2, I told you about the photo with the trees and the use of ChatGPT to extract a table from that photo. I also promised you that in the next chapter (this one), you would see how to create Excel tables directly from photos. Well, now it’s time to talk about it.

          Imagine that you have made notes on a piece of paper relating to the expenses you have incurred recently, as shown in Figure 3-7 (The figure is deliberately faded and not optimal for reasons I will explain shortly). 

          
            
            Figure 3-7. A photo of a handwritten table

          

          Now, imagine that you want to transcribe your paper table (and the total amount row) into an Excel sheet. The traditional approach involves manual transcription from paper to computer. But by using ChatGPT, you can speed up the operation.

          You can proceed in two ways. In the first mode, proceed using the ChatGPT web interface and follow these steps:

          
            	
              Before connecting to the ChatGPT web interface, take a piece of paper and write a table by hand. For example, you can copy the table in Figure 3-7 (typed out in Table 3-1). Also, add the Total Amount row, as shown at the bottom of Figure 3-7.

            
          
            Table 3-1. An example of a table
            
              
                	Date
                	Category
                	Description
                	Amount
                	Payment Method
              

            
            
              
                	
                  2024/12/12

                
                	
                  Grocery

                
                	
                  Weekly Grocery

                
                	
                  $43.00

                
                	
                  Cash

                
              

              
                	
                  2024/12/12

                
                	
                  Presents

                
                	
                  Present for Giulia

                
                	
                  $12.00

                
                	
                  Credit Card

                
              

            
          



            	
              Take a photo of your table and the total amount, as shown in the original photo of Figure 3-7. It doesn’t matter whether the photo is excellent as long as it is legible, like the one in Figure 3-7. Don’t worry about lights, shadows, or taking perfect photos.

            

            	
              Upload the photo to ChatGPT via the upload button and use the following prompt:

            
          Format the attached table as an Excel file and make it downloadable. 
Follow this workflow to build the Excel file: 
Populate columns and rows 
Format as an Excel Table except for the row Total Amount
Calculate the Total Amount using a formula (Sum of the Amount column)


            	
              Download the Excel file produced by ChatGPT. You should get something very similar to Figure 3-8.

              
                
                Figure 3-8. The Excel file produced by ChatGPT

              

            

            	
              As a bonus, you can also ask ChatGPT to add more consistent lines. This is particularly useful if you want to generate example files for other cases. Use this prompt, continuing the conversation with ChatGPT:

            
          Populate this table with 15 consistent rows.

          Figure 3-9 shows a possible result generated by ChatGPT.

          
            
            Figure 3-9. The result of this prompt: Populate this table with 15 consistent rows.

          



          If you have followed all the steps described above, you have noticed a minor complication. You probably took the photo with your smartphone, uploaded it to the cloud, downloaded it from your computer, and finally uploaded it to ChatGPT. This operation is cumbersome and slow. 

          There is an alternative way to proceed: the ChatGPT app for smartphones! You can download the official ChatGPT app from your favorite app store, log in to your account, and have ChatGPT within reach of your smartphone. Everything I have said so far about the web interface applies to the smartphone app. So you can decide from time to time whether to use the web interface or the app.

          In this specific case, I still suggest you use the app when creating the template from a photo. After logging into the app, you have an interface available where you can directly take the picture, as shown in Figure 3-10.

          
            
            Figure 3-10. The ChatGPT smartphone app interface with the ability to upload photos.

          

          After taking the photo directly in ChatGPT, perform steps 3-4 described previously. If you don’t want to download the Excel file to your smartphone, you can continue the conversation via the web interface.

          Tip

            An interesting aspect of ChatGPT is that it may store conversations, which you can access via a bar on the left. These conversations are available in both the app and the web version, so you can start a conversation in the app and continue it in the web interface and vice versa. This option is not available if you start a temporary chat.

          

        

        
          Exercise 2

          If you haven’t recycled it, find the latest supermarket flyer you received in the mail and select a page of your choice. Take a photo and input it to ChatGPT using the following prompt:

          Format the attached table as an Excel file and make it downloadable. 
Follow this workflow to build the Excel file: 
Populate columns and rows with the items in the flyer
Format as an Excel Table

          I tried this exercise, and the result was quite good. ChatGPT organized the items into a table with the structure shown in Table 3-2 and identified almost all items on the page.

          
            Table 3-2. The table structure generated by ChatGPT from the flyer page.
            
              
                	Category
                	Product Name
                	Size/Quantity
                	Price (€)
              

            
            
              
                	
                	
                	
                	
              

            
          

          From the experience of this exercise, I always advise you to check the correctness of the results produced by ChatGPT.

          At this point, you should have a pretty clear idea of ​​how to use ChatGPT to generate templates, either from scratch or from a photo or image. In the next section, you will see the concept of Autofill and how to use ChatGPT to speed up this operation.

        

      

      
        Autofill

        Autofill in Excel is a function that allows you to automatically fill a series of cells with values, formulas, or patterns based on a predefined template. You can use Autofill to complete number sequences, days of the week, months, formulas, and more.

        Suppose you have the table shown in Table 3-3 (available in the book’s GitHub repository as 03/autofill.xlsx.

        
          Table 3-3. An example table
          
            
              	#
              	Date
              	Day of Week
            

          
          
            
              	
                1

              
              	
                2024-01-01

              
              	
            

            
              	
                2

              
              	
                2024-01-02

              
              	
            

            
              	
                3

              
              	
                2024-01-03

              
              	
            

          
        

        The first column is a progressive number, the second is a progressive date in the format YYYY-MM-DD, and the third is the week’s day. It is currently empty, but you would like it filled with the day of the week corresponding to the date. In the example, the first date should correspond to Monday, the second to Tuesday, and so on, given that January 1, 2024, was a Monday. 

        Suppose you want to extend the table using Autofill to have dates up to January 31, 2024. Let’s see how to perform this operation first manually using only Excel and then with ChatGPT. 

        To proceed manually, do the following:

        
          	
            Select the first three dates and move the cursor to the bottom right, where there is a small square called Fill Handle, as shown in Figure 3-11.

            
              
              Figure 3-11. How to activate Autofill in Excel (step 1)

            

          

          	
            Move the mouse cursor until it becomes a black cross, then click and drag down a few rows until the date 2024-01-08 appears, as shown in Figure 3-12.

            
              
              Figure 3-12. How to activate Autofill in Excel (step 2)

            

            Release the cursor. All dates are populated automatically through 2024-01-08, as shown in Table 3-4.


        
          Table 3-4. The result of the Autofill process
          
            
              	#
              	Date
              	Day of Week
            

          
          
            
              	
                1

              
              	
                2024-01-01

              
              	
            

            
              	
                2

              
              	
                2024-01-02

              
              	
            

            
              	
                3

              
              	
                2024-01-03

              
              	
            

            
              	
              	
                2024-01-04

              
              	
            

            
              	
              	
                2024-01-05

              
              	
            

            
              	
              	
                2024-01-06

              
              	
            

            
              	
              	
                2024-01-07

              
              	
            

            
              	
              	
                2024-01-08

              
              	
            

          
        
          

        

        
          Exercise 3

          Repeat the same operations just described for the # column containing the progressive number and the Day of Week column. To use the Autofill function in the latter case, remember to write the values for at least the first two lines.

          At this point, you are ready to repeat the same operations using ChatGPT. Remember that each prompt must be structured into three parts: context, main point, and end. In our example, we directly load the autofill.xlsx dataset into ChatGPT, and this forms our context. Then we ask ChatGPT to fill in the missing values (main points). Basically we use ChatGPT to perform the autofill for us automatically. Finally, we tell ChatGPT to format the output as an Excel table, maintaining the style of the original file. 

          Tip

            Using ChatGPT to perform Autofill is particularly useful for populating a dataset with many values. If you want to fill a few values, you can still use ChatGPT, but the advantage over the manual solution is minimal.

          

          Use the following prompt:

          Consider the table attached. 

Using Autofill, populate all the table columns with dates starting from 2024/01/01 to 2024/01/08. Use the correct day of week (Monday, ...). 

Format the resulting table as an Excel table and keep the original table layout. 

          ChatGPT performs the operations and then generates the file in Excel format to download. Figure 3-13 shows a portion of the file generated by ChatGPT.

          
            
            Figure 3-13. The file generated by ChatGPT after running the Autofill

          

          In some cases, the file generated by ChatGPT may not contain data formatted as a table and with the same layout as the original file. In this case, continue the conversation with ChatGPT, repeating the last part of the prompt:

          Format the resulting table as an Excel table and keep the original table layout. 

          At most, after a couple of tries, ChatGPT should generate the correctly formatted file.

          As you’ve seen, you can use Autofill to automatically fill the rows of a table with predefined values or sequences. If you have a lot of values to fill out, use ChatGPT to speed up this operation. But what if you want to extend your data with data external to your source dataset? You can still use ChatGPT. Let’s see how in the next section.

        

      

      
        Data Enrichment

        Data enrichment consists of extending an original dataset with data from other sources. You can extend a dataset with geographic data, descriptions, or other information from external sources, such as the web, or internal sources, such as other datasets from the same source. To extend a dataset with other data, the dataset must not contain duplicates and have at least one column to be used as a unique identifier. 

        Let’s take an example. Suppose you have a workbook with two tables organized into two separate worksheets. You can download the workbook from the book’s GitHub repository as 03/data_enrichment.xlsx. The first table, called Books (available in the Books tab), contains book titles and status (whether it has been read, unread, or reading), as shown in Table 3-5.

        
          Table 3-5. The table contained in the Books tab in the data_enrichment.xlsx example file
          
            
              	Title
              	Status
            

          
          
            
              	
                Effective Data Storytelling

              
              	
                Read

              
            

            
              	
                Become a Great Data Storyteller

              
              	
                To read

              
            

            
              	
                Storytelling with Data

              
              	
                To read

              
            

            
              	
                The Data Storyteller’s Handbook

              
              	
                Reading

              
            

          
        

        The second table, called Info (available in the Info tab), contains book titles, authors, and years of publication, as shown in Table 3-6.

        
          Table 3-6. The table contained in the Info tab in the data_enrichment.xlsx example file
          
            
              	Title
              	Author
              	Year
            

          
          
            
              	
                The Data Storyteller’s Handbook

              
              	
                Kat Greenbrook

              
              	
                2023

              
            

            
              	
                Storytelling with Data

              
              	
                Cole Nussbaumer Knaflic

              
              	
                2015

              
            

            
              	
                Effective Data Storytelling

              
              	
                Brent Dykes

              
              	
                2019

              
            

            
              	
                Become a Great Data Storyteller

              
              	
                Angelica Lo Duca

              
              	
                2025

              
            

          
        

        Suppose you want to extend the first table with the information contained in the second. The two tables share a common column, Title, which will act as a unique identifier for matching between the two tables. 

        Use the function VLOOKUP() to extend the first table with the data from the second. The function VLOOKUP() has the following syntax:

        =VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup])

        
          	
            lookup_value
          

          	
            The value you want to look for in the first column of the table_array table.

          

          	
            table_array
          

          	
            The table or range of cells to search for the value. The first column of this range is where VLOOKUP() searches for the lookup_value.

          

          	
            col_index_num
          

          	
            The number of the column (in the table range) from which to take the value to be returned. The first column always has the number 1.

          

          	range_lookup (optional)

          	
            Specify the match type. If set to TRUE (or omitted), it looks for an approximate match (values ​​should be sorted in ascending order). If set to FALSE, it searches for an exact match.

          

        

        The function returns the value in the column specified by col_index_num. Apply the function VLOOKUP() to the Books table as follows:

        
          	
            Select cell C2 in the Books worksheet, as in Figure 3-14.

          
        
          
          Figure 3-14. How to enrich data using VLOOKUP() (step 1)

        


          	
            Write the following formula to select the author: 

          
        =VLOOKUP([@Title],Info[#All],2,FALSE) 

        Then press the Enter key. Figure 3-15 shows the result.

        
          
          Figure 3-15. How to enrich data using VLOOKUP() (step 2)

        


          	
            Rename the column to Author.

          

          	
            Repeat the operation for the Year column (using a formula). Figure 3-16 shows the final result. You can find the solution in the book’s GitHub repository as 03/data_enrichment_manual.xlsx.

            
              
              Figure 3-16. The final result after data enrichment

            

          

        

        So far, you have seen how to extend the dataset manually. This example required that I already have the enriched data in a separate table. However, you may not have the data immediately, and want to extract it from an external source, such as the web. In this case, ChatGPT can help you.

        To demonstrate how to extract data from the web, we’ll use a simplified version of the dataset, which contains only the Books table, and we will ask ChatGPT to fill it using the data it knows. You can find this simplified file version in the book’s GitHub repository as 03/data_enrichment_simplified.xlsx.

        First, let’s define a prompt that consists of three parts: context, main point, and end. As a context, we directly use the data_enrichment.xlsx dataset, which we load into ChatGPT using the appropriate button to load data. Let’s start the conversation with ChatGPT by writing the following prompt:

        Consider the table Books in the first worksheet of the attached file. Extend the table Books with the following columns: author, year of publication, publisher. Extract the required information from the web. Format the resulting table as an Excel Table. Keep the original table layout and style.

        ChatGPT generates the result shown in Figure 3-17, but it is not formatted as an Excel file. Furthermore, the table does not contain some data because it is not available in the GPT-4o model used by ChatGPT in this experiment.

        
          
          Figure 3-17. The table enriched by ChatGPT does not contain all the required information

        

        Warning

          In some cases, ChatGPT can hallucinate, meaning it generates incorrect results. Always remember to check the results produced by ChatGPT before using them!

        

        Note

          In some cases, ChatGPT may not allow you to download the generated file because it remains temporarily stored in memory. If you attempt to download the file after a long inactivity, it may have already been deleted and is no longer available.

          In other cases, ChatGPT might encounter issues during the file generation or download process, such as a timeout, a server error, or a browser-related restriction. To avoid losing access to the file, download it as soon as it’s created.

        

        To solve the problem, ask ChatGPT to repeat the operation by searching for information on the Web. Select the “Search the web” button in the ChatGPT interface, as shown in Figure 3-18.

        
          
          Figure 3-18. The Search button in the ChatGPT web interface

        

        Once the button is enabled, write this prompt:

        Repeat the operation.

        ChatGPT now generates a new table, as shown in Figure 3-19.

        
          
          Figure 3-19. Using the Search function, the enriched table contains all the required information 

        

        The table is not yet downloadable as an Excel file. So, ask ChatGPT to format the table as an Excel file, keeping the original formatting and data present in the source file:

        Format the resulting table as an Excel Table. Keep the original table layout and style.

        At this point, the file is ready, as shown in Figure 3-20. 

        
          
          Figure 3-20. The final file generated by ChatGPT

        

        Compared to the original file, ChatGPT did not maintain the original theme of the table but still enriched the data correctly.

        From this example, we learned the following about ChatGPT:

        
          	
            It automates most operations, such as calculations and data enrichment. 

          

          	
            Sometimes you need to ask it several times to format the table as a table and keep the original style. 

          

          	
            It doesn’t always maintain the original table’s theme and style.

          

        

        Tip

          Sometimes, ChatGPT fails to generate the file to download and proposes instructions to create the file by yourself. In this case, you can ask ChatGPT to retry, for example, using the following prompt: Please try again. Alternatively, you can follow the instructions provided by ChatGPT and apply them by hand to your original Excel file.

        

        
          Exercise 4

          Write instructions for ChatGPT to populate Table 3-7 with the country name and geographic coordinates.

          
            Table 3-7. The table to enrich.
            
              
                	City
                	Country
                	Latitude
                	Longitude
              

            
            
              
                	Pisa
                	
                	
                	
              

              
                	New York
                	
                	
                	
              

              
                	Sydney
                	
                	
                	
              

              
                	Paris
                	
                	
                	
              

            
          

          The Excel file containing the table in the book’s GitHub repository is available as 03/exercise4.xslx, and the solution is here: 03/exercise4_solution.txt.

          Note

            I conclude this chapter with a personal reflection. Last night, I had a moment of pure contemplation: I stopped to observe my nine-year-old daughter Giulia while she played the piano. She was enchantingly graceful. The melody that filled the room was so sweet and enveloping that it touched the deepest strings of the soul. At that moment, a thought took shape in my mind. ChatGPT, upon closer inspection, is like a piano: it has infinite keys and can create extraordinary melodies. However, just as a piano remains silent and inert without someone who can play it, ChatGPT remains unused if you don’t approach it with the proper prompts. It is human interaction, awareness, and creativity that give it voice and make it extraordinary.

          

        

      

      
        Summary

        In this chapter, you learned how to speed up some common operations using ChatGPT. In the next chapter, you will learn how to use ChatGPT to perform advanced operations.

        
          	
            A template is a predefined file with a ready-made structure and format for specific tasks. You can use ChatGPT to speed up template creation. Structure the prompt following a precise order: first, define the context and then the design of the workbook, with the number of tables and their structure, data validation, additional elements and style.

          

          	
            With ChatGPT, you can create a template from scratch or use a photo of a hand-made sketch. You can even ask ChatGPT to extract Excel tables from flyers or other images.

          

          	
            Autofill in Excel is a useful function for automatically filling a series of cells with values, formulas, or patterns based on a predefined template. ChatGPT can speed up the auto-filling process if the number of data to insert is large.

          

          	
            Enriching a dataset involves extending an original dataset with data from other sources. Use ChatGPT’s Search function to enrich a dataset with information extracted from the web.

          

        

      

      
        Activity

        Solve the word puzzle in Figure 3-21 by circling all the words you see. In the end, you will discover something about Autofill by reading the letters that are not circled, which will now form words. You can find the solution in Appendix A.

        
          
          Figure 3-21. The crossword puzzle to solve

        

        Words to search for:

        
          	
            AUTOFILL

          

          	
            CHATGPT

          

          	
            CONTEXT

          

          	
            END

          

          	
            EXCEL

          

          	
            MAINPOINT

          

          	
            PROMPT

          

          	
            ROW

          

          	
            TABLE

          

          	
            TEMPLATE

          

          	
            WEB SEARCH

          

        

        Autofill

        ________________________________________________________________________

      

    



      Chapter 4. Advanced Operations with ChatGPT

      
A Note for Early Release Readers


With Early Release ebooks, you get books in their earliest form—the author’s raw and unedited content as they write—so you can take advantage of these technologies long before the official release of these titles.


This will be the 4th chapter of the final book. Please note that the GitHub repo will be made active later on.


If you have comments about how we might improve the content and/or examples in this book, or if you notice missing material within this chapter, please reach out to the editor at ccollins@oreilly.com.



      
      When I started programming in the early 2000s, fixing a bug in the code was a real challenge. If something wasn’t working, you didn’t even know where to start. It could take hours, sometimes days, of trying to check line by line in the hope of finding that bug in the code. Then, suddenly, a colleague or friend would arrive and, with a quick glance, identify the problem and point it out to you as if it were the most obvious thing in the world. And you, between disbelief and gratitude, thanked them heartily. 

      Then came the Internet, Web 2.0, and programming forums. If a code generated problems, all you had to do was search on a search engine, and sooner or later, you would find someone who had had the same problem and had already solved it. Debugging times have shortened dramatically. 

      Today, with ChatGPT, everything is even faster. Just paste the code and ask where the error is. You’ll have the solution in a few minutes, sometimes in a few seconds. When I think about twenty years ago, when I could have spent entire days on a single bug, the progress is impressive. But it doesn’t end there. With generative AI, you no longer have to write code; ChatGPT does it directly. Just describe the problem, and it returns the code ready to use, both for programming in languages such as Python, Java, or C# and for creating advanced and efficient formulas in Excel. And that’s exactly what you’ll see in this chapter. More precisely, this chapter covers the following topics:

      
        	
          Using ChatGPT to analyze a dataset

        

        	
          Using ChatGPT for PivotTables

        

        	
          Combining ChatGPT and macros

        

        	
          Using ChatGPT to write VBA code

        

      

      Let’s start with the first one, using ChatGPT to analyze a dataset.

      
        Using ChatGPT to Analyze a Dataset

        The previous chapter showed how to use AI to help you write or understand formulas. However, having formulas is not enough, and knowing how to use it is not enough. You also need to use them to perform the proper data analysis. For example, you might have a beautiful dataset and know all the Excel formulas, but you have no idea what to ask of that dataset and what formula to use to extract something important from your data. Well, AI and, in particular, ChatGPT can help you with this. In this section, you’ll see how AI can analyze the dataset and generate advanced formulas. To analyze the dataset, follow the flow described in Figure 4-1.

        
          [image: A diagram of a question  AI-generated content may be incorrect.]
          Figure 4-1. The workflow for analyzing a dataset.

        

        A typical workflow in more detail might go like this:

        
          	
            Start with your dataset in Excel. Extract a part containing the column names and possibly some example lines (or use the entire dataset if it is not too large).

          

          	
            Upload it to ChatGPT. (Alternatively, as seen in previous chapters, you could provide ChatGPT context about the dataset.)

          

          	
            Ask ChatGPT to extract the category from your dataset. Examples of categories include finance, environment, health, society, and so on. This step is essential to help ChatGPT take the next step.

          

          	
            Ask ChatGPT to define relevant questions for your dataset. For example, Table 4-1 shows some possible questions to ask about the data based on the categories to which it belongs.

          
        
          Table 4-1. A list of possible questions based on the data category.
          
            
              	Category
              	Requests 
            

          
          
            
              	Health
              	
                What are the main risk factors for a particular disease?

                How do diagnoses vary over time and space?

                How effective is a specific treatment?

              
            

            
              	Finance
              	
                What are the trends in the financial markets?

                What factors influence stock prices?

                What is the average return on an investment portfolio?

              
            

            
              	Environment
              	
                ‘What are the primary sources of pollution in a region?

                How does air quality change over time?

                What measures can reduce the environmental impact?

              
            

            
              	Social media
              	
                What are the trends in online conversations?

                How does user engagement vary across different platforms?

                What is the general sentiment on a particular topic?

              
            

            
              	Education
              	
                What are the factors that influence student achievement?

                How does the school dropout rate vary?

                What teaching strategies improve learning?

              
            

            
              	E-commerce
              	
                Which products are best selling in a given period?

                What factors influence purchasing behavior?

                Which marketing strategies are most effective?

              
            

            
              	Transport
              	
                What are the most common traffic patterns in a city?

                What are the main factors causing transport delays?

                How do we optimize routes to reduce fuel consumption?

              
            

            
              	Energy
              	
                What are the most efficient energy sources?

                How does energy consumption vary over time?

                What strategies can reduce energy waste?

              
            

            
              	Manufacturing
              	
                What are the most common causes of failures in production lines?

                How to improve assembly line efficiency?

                Which materials offer the best value for money?

              
            

            
              	Sport
              	
                What factors influence athlete performance?

                Which training strategies are most effective?

                How to predict the risk of accidents?'

              
            

          
        

        

          	
            Once you’ve identified the questions, ask ChatGPT to answer them using Excel formulas. 

          

          	
            Tell ChatGPT to implement the responses into your original dataset and make it downloadable. 

          

        

        Let’s apply this workflow to a full example. 

        
          Dataset

          Consider the synthetic dataset available in the book’s GitHub repository at 04/sales_dataset.xlsx and shown in Figure 4-2.

          
            
            Figure 4-2. An extract from the sales dataset.

          

          The dataset shows product sales and contains the following fields:

          
            	Transaction ID

            	
              Unique identifier for each sale

            

            	Date of Sale

            	
              Date of the transaction (YYYY-MM-DD)

            

            	Product ID

            	
              Unique identifier for the product sold

            

            	Product Name

            	
              Name or description of the product

            

            	Quantity Sold

            	
              Number of units sold

            

            	Unit Price

            	
              Selling price per unit

            

            	Total Sale Amount

            	
              Total revenue from the sale (Quantity × Unit Price - Discounts)

            

            	Payment Method

            	
              Cash, Credit Card, PayPal, etc.

            

            	Store Location

            	
              City, region, or country where the sale occurred

            

            	Customer Type

            	
              New, Returning, VIP, etc.

            

          

        

        
          Extract the Category and Relevant Questions

          Start a new conversation with ChatGPT, load the dataset, and execute the following prompt:

          Consider the attached dataset describing an Excel table named MainTable. Identify the category to which the dataset belongs (finance, health, and so on) and list the top 5 helpful questions to analyze this dataset.

          In our present case, ChatGPT associated the dataset with the Sales/Retail/Business category and generated the following questions:

          
            	
              Which product generates the highest revenue?

            

            	
              What are the trends in sales over time?

            

            	
              Which store location has the highest total sales?

            

            	
              What is the distribution of payment methods used by customers?

            

            	
              How does customer type (New, Returning, VIP) impact sales and revenue?

            

          

          Warning

            By repeating the operation several times and starting a new conversation each time, you’ll notice that the questions change slightly, but overall, they are always the same.

          

          Tip

            You can ask ChatGPT to generate five more questions by writing the following prompt:

            List 5 more questions. 
Repeat to get five more questions each time.

          

        

        
          Answers Generation

          Now, ask ChatGPT to generate the answers to the questions using Excel. Use the following prompt:

          Write the Excel formula or steps to answer each question and how to implement it in Excel. Don’t use PivotTables. Use the table name MainTable and column names to write formulas. Write the general formula or steps to follow whenever possible without focusing on a specific value.

          You specifically ask ChatGPT not to use PivotTables because, as we will see later in this chapter, in its current version (as of this writing in early 2025), ChatGPT can still not apply PivotTables to an Excel file independently. However, if at the time you are reading this, you use a version of ChatGPT that also manages PivotTables, feel free to delete the text “Don’t use PivotTables” from the prompt. For each answer, ChatGPT lists the steps to implement it in Excel. For example, in this case, to implement the answer to question 1, Which product generates the highest revenue? ChatGPT generated the following response:

          To calculate total revenue for each product, use SUMIFS:

=SUMIFS(MainTable[Total Sale Amount], MainTable[Product Name], A2)

- Replace A2 with the product name cell reference.
- Copy the formula for all unique product names.

Steps:
- List unique product names in a new column.
- Use the SUMIFS formula to sum Total Sale Amount for each product.
- Identify the highest value using MAX or by sorting the revenue column in descending order.

          First, ChatGPT proposes the formula to calculate the answer and then provides the steps to implement it. In the example, ChatGPT proposes the use of the function SUMIFS, which sums the values in a range that satisfy multiple criteria. The syntax is as follows:

          SUMIFS(sum_range, criteria_range1, criteria1, [criteria_range2, criteria2], ...)

          Let’s unpack that:

          
            	
              sum_range
            

            	
              The range of values to sum.

            

            	
              criteria_range1
            

            	
              The first range to apply a condition to.

            

            	
              criteria1
            

            	
              The condition to be met in criteria_range1.

            

            	
              criteria_range2, criteria2 (optional)
            

            	
              Additional conditions to filter the sum.

            

          

          In the example generated by ChatGPT, the function SUMIFS sums the values of the Total Sale Amount column of the MainTable table, but only for the rows in which the value of the Product Name column corresponds to the value present in cell A2. ChatGPT, therefore, does not directly answer the question Which product generates the highest revenue?, but selects the relevant data (and processes it) to help you answer the question more easily.

        

        
          Answers Implementation

          At this point, ask ChatGPT to implement the answers it gave in the original file. Use the following prompt:

          Add a sheet to the original file for Question 1 named as the question. Format the original dataset as an Excel Table and name it 'MainTable.' Make the file downloadable. Implement all required steps to answer Question 1. If the response involves a formula, apply it in the corresponding Excel sheet.  Ensure that calculated values are replaced with formulas and all the steps you have listed to answer the question are implemented. Make the file downloadable.

          In my case, ChatGPT generated an Excel file, which you can download from the book’s GitHub repository at 04/sales_dataset_q1.xlsx. Figure 4-3 shows the portion of the generated file related to Question 1. Interestingly, the values in the Total Revenue column are calculated as formulas.

          
            
            Figure 4-3. The worksheet generated by ChatGPT in response to the question of which product generates the highest revenue?

          

          To answer the question Which product generates the highest revenue? You need to do a little extra work. Proceed as follows:

          
            	
              With the mouse, select all the non-empty cells of the Top Revenue Product worksheet, and from the Home tab of the Ribbon, select Format as Table, choose a format, and confirm the range and headings in a dialog box (Figure 4-4).

              
                [image: A screenshot of a spreadsheet  AI-generated content may be incorrect.]
                Figure 4-4. Select the non-blank cells of the worksheet that answer Question 1 and format them as a table.

              

            

            	
              Select the arrow at the right of the Total Revenue column and click Sort Largest to Smallest (Figure 4-5). Then click OK, if needed.

              
                
                Figure 4-5. Select the arrow to open the drop-down menu. Select Sort Largest to Smallest.

              

            

            	
              The first product in the table answers the question Which product generates the highest revenue? In our case, the product that produces the most revenue is Headphones, as shown in Figure 4-6.

              
                [image: A screenshot of a computer  AI-generated content may be incorrect.]
                Figure 4-6. The first row of the table answers the question which product generates the highest revenue?

              

            

          

          From the procedure shown to answer the first question, we can make some reflections:

          
            	
              Use ChatGPT to build the framework for answering your data questions.

            

            	
              Use your knowledge and experience to answer the questions based on what ChatGPT generated.

            

          

          ChatGPT, therefore, automates basic and repetitive operations, but the final answer is always up to you.

          After you answer the first question, ask ChatGPT to answer the remaining questions, one at a time. Use the following prompt to answer the second question:

          Repeat for Question 2. Use the Excel file you have generated in the previous step ensuring that all the formulas previously calculated are maintained.

        

        
          Exercise 1

          Check if the answer ChatGPT provided to question 2, What are the trends in sales over time?, is correct. If necessary, refine your answer. In my case, you can find the answer to question 2 in the book’s GitHub repository at 04/sales_dataset_q2.xlsx. As in the answer to question 1, in this case ChatGPT generated the framework to answer the question but has not responded definitively. For example, you can complete the answer by inserting a graph showing the sales trend.

          Follow these steps:

          
            	
              Turn non-blank cells into a table (as described in the section “Answers Implementation”).

            

            	
              Insert a graph visually showing the trend: select the Insert tab from the Ribbon → Insert Line or Area Chart → Line Figure 4-7).

              
                
                Figure 4-7. Insert a graph to answer the question What are the trends in sales over time?

              

            

          

          Tip

            Challenge: Ask ChatGPT to generate the graph and insert it into the output file.

          

        

        
          Extend to All Questions

          After answering Question 2, repeat the process for Questions 3, 4, and 5. For example, to address Question 3, enter the prompt:

          Repeat for Question 3. Use the Excel file you have generated in the previous step ensuring that all the formulas previously calculated are maintained.

          ChatGPT adds a worksheet to the file whenever it answers a question. You can download the files generated in my case from the book’s GitHub repository at 04/sales_dataset_q2.xlsx, 04/sales_dataset_q3.xlsx, 04/sales_dataset_q4.xlsx, and 04/sales_dataset_q5.xlsx. Qx indicates the question number. The file relating to question Qx contains all answers from 1 to x. Figure 4-8 shows the structure of the final file (sales_dataset_q5.xlsx), which answers all five questions.

          
            
            Figure 4-8. ChatGPT answered each question using a separate worksheet.

          

          Table 4-2 shows the questions and the process ChatGPT followed to answer them in my case.

          
            Table 4-2. Questions and answers relating to the sales dataset.
            
              
                	Question
                	Answer 
                	Used Formula
              

            
            
              
                	
                  Which product generates the highest revenue

                
                	
                  List unique product names and use SUMIFS to calculate the total revenue for each.

                
                	
                  
                    =SUMIFS(MainTable[Total Sale Amount], MainTable[Product Name], A2)
                  

                
              

              
                	
                  What are the trends in sales over time?

                
                	
                  List unique dates and use SUMIFS to calculate total sales per date.

                
                	
                  
                    =SUMIFS(MainTable[Total Sale Amount], MainTable[Date of Sale], A2)
                  

                
              

              
                	
                  Which store location has the highest total sales?

                
                	
                  List unique store locations and use SUMIFS to calculate total sales per store.

                
                	
                  
                    =SUMIFS(MainTable[Total Sale Amount], MainTable[Store Location], A2)
                  

                
              

              
                	
                  What is the distribution of payment methods used by customers?

                
                	
                  List unique payment methods and use COUNTIF to count occurrences.

                
                	
                  
                    =COUNTIF(MainTable[Payment Method], A2)
                  

                
              

              
                	
                  How does customer type impact sales and revenue?

                
                	
                  List unique customer types and use SUMIFS to calculate total revenue per type.

                
                	
                  
                    =SUMIFS(MainTable[Total Sale Amount], MainTable[Customer Type], A2)
                  

                
              

            
          

          In most cases, ChatGPT proposed using the SUMIFS() function. You could have achieved a similar result using PivotTables. However, there are differences between SUMIFS() and PivotTables. Table 4-3 shows some pros and cons of SUMIFS() vs. a PivotTable.

          
            Table 4-3. A quick comparison between SUMIFS() and a PivotTable.
            
              
                	
                	PROS
                	CONS
              

            
            
              
                	
                  
                    SUMIFS()
                  

                
                	
                  Automatic update without having to update the table manually

                
                	
                  The formula SUMIFS() can become complex and difficult to manage in sheets with many conditions.

                
              

              
                	
                  PivotTable

                
                	
                  It allows you to analyze and summarize large amounts of data quickly.

                  It can calculate sums, averages, counts, and other operations without writing complex formulas.

                
                	
                  It is not dynamic in real time: if the data changes, it must be updated manually.

                
              

            
          

          Both are useful and allow you to achieve similar results. It is up to you, based on the pros and cons, to evaluate which one to use.

          At the time of writing this chapter, ChatGPT can’t add PivotTables automatically to an Excel file. However, you can still use ChatGPT as a teacher to learn how to build a specific PivotTable. Let’s see how in the next section.

        

      

      
        Using ChatGPT for PivotTables

        A PivotTable in Excel is a tool that helps you quickly summarize and analyze data. You can use PivotTables to easily organize, group, and calculate data (like sums or averages) by dragging and dropping fields, making it easier to find patterns and insights. Use ChatGPT as a teacher to describe the steps to implement a PivotTable.

        Consider the following example to understand how to proceed. Implement the answer to question 1, Which product generates the highest revenue?, using PivotTables. Continuing the conversation in the same chat from which you downloaded the various Excel files with the answers, ask ChatGPT for the steps to implement Question 1 using PivotTables. Use the following prompt:

        Describe the steps to implement question 1 using PivotTables.

        In my case, ChatGPT provided the following response:

        Step 1: Select Your Data

  1. Open your Excel file containing the dataset.
  2. Click anywhere inside the dataset (MainTable) to automatically detect data for the PivotTable.

Step 2: Insert a PivotTable

  1. Go to the Insert tab on the Excel ribbon.
  2. Click PivotTable.
  3. In the Create PivotTable window:
    - Ensure the Table/Range is set to MainTable (if already formatted as a table).
    - Choose New Worksheet for the PivotTable location.
    - Click OK.

Step 3: Configure the PivotTable Fields

  1. In the PivotTable Fields panel, drag and drop:
    - "Product Name" into the Rows area.
    - "Total Sale Amount" into the Values area.
  2. Ensure that the "Total Sale Amount" field is set to Sum (Right-click → Summarize Values By → Sum).

Step 4: Sort to Identify the Top Product

  1. Click any value in the Total Sale Amount column inside the PivotTable.
  2. Go to the Data tab and click Sort.
  3. Choose to Sort by Total Sale Amount in Descending Order (Largest to Smallest).
  4. The top product will now be the first entry in the table.

Step 5: Apply Formatting (Optional)

  1. Click on the Total Sale Amount column.
  2. Go to the Home tab → Click Number Format → Select Currency or Number formatting.
  3. Adjust column widths for better readability.

Step 6: Identify the Product with the Highest Revenue

  - The product with the highest total revenue will be the first row in the sorted PivotTable.
  - Optionally, use Conditional Formatting (Home → Conditional Formatting → Data Bars or Color Scales) to highlight the highest revenue product.

        By following the steps described by ChatGPT, you get the PivotTable shown in Figure 4-9, which is very similar to the table in Figure 4-6, although the formatting is much better (thanks to steps 5 and 6).
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          Figure 4-9. The PivotTable implemented using the steps suggested by ChatGPT.

        

        In providing the answer, ChatGPT also added the following bonus:

        Bonus: Create a Chart
  1. Click anywhere inside the PivotTable.
  2. Go to the Insert tab → Select Column Chart or Bar Chart.
  3. The chart will visually display the revenue distribution by product.

        With this bonus, ChatGPT explains how to add a chart. You obtain the graph shown in Figure 4-10 by following the steps described.
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          Figure 4-10. The column chart relating to the PivotTable of Question 1.

        

        So far, you have seen how to use ChatGPT to analyze a dataset and, as a teacher, help build PivotTables. However, ChatGPT can go further by generating macros and VBA code. Let’s see how in the next section.

      

      
        Macros and VBA

        A macro in Excel is a set of automated commands that allow you to quickly perform repetitive tasks, such as formatting data, creating reports, or performing complex calculations. You can write macros using the VBA (Visual Basic for Applications) programming language or record macros without writing code. 

        Before using macros, you must activate them following these steps (in Windows), if not already activated:

        
          	
            Open Excel and go to File → Options.

          

          	
            Select Trust Center in the left menu.

          

          	
            Click Trust Center Settings.

          

          	
            In the window that opens, select Macro Settings.

          

          	
            Choose the Disable VBA macros with notification option (recommended).

          

          	
            Click OK to confirm your changes.

          

        

        If you use Mac OS, follow these steps: Open Excel and go to Excel → Preferences → Security → Disable all macros with notification.

        At this point, customize the Ribbon to display the Macros commands. Follow these steps to enable the Developer tab, which also contains macros:

        
          	
            Choose File → Options (Windows) or Excel → Preferences (Mac OS).

          

          	
            Select Customize Ribbon (Windows) or Ribbon & Toolbar (Mac OS)

          

          	
            Under Customize the Ribbon, check the Developer option and click OK (Figure 4-11)

        
          
          Figure 4-11. Select Customize Ribbon → Main Tabs → Developer to add the Developer tab to the Ribbon.

        

                  

        

        Once you have performed these operations, you will find the Developer tab in the Ribbon, which should appear as shown in Figure 4-12 (in Windows) or Figure 4-13 (in Mac OS).
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          Figure 4-12. The Developer tab of the Ribbon (Windows)
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          Figure 4-13. The Developer tab of the Ribbon (Mac OS)

        

        At this point, you are ready to use macros. We will look at two strategies. The first is to record a macro, and the second is to write the VBA code to generate the macro. Let’s start with the first step: recording a macro.

        
          Recording a Macro

          Let’s use an example to understand how macros work. Open the file 04/sales_dataset_q5.xlsx, which results from the previous exercise (Figure 4-8). Inside the workbook, in addition to the main worksheet containing the main dataset, you will find five worksheets, one for each question. Each worksheet includes ranges of values ​​not formatted as Excel tables (Figure 4-6). Let’s now write a macro to transform the data contained in each worksheet into a table. We record the macro without writing code in VBA for a single worksheet and then apply it to all other worksheets.

          To record a macro that converts the second worksheet into a table and formats the revenue column as currency in Excel, follow these steps:

          
            	
              Navigate to the second worksheet, Top Revenue Product.

            

            	
              Go to the Developer tab and click Record Macro. In the Record Macro dialog box:

              
                	
                  Enter a Macro Name (e.g., ConvertToTable).

                

                	
                  Choose where to store the macro (This Workbook).

                

                	
                  Optionally, assign a shortcut key (e.g., Ctrl+Shift+T). Using the Shift command prevents you from overriding the Ctrl+t shortcut that converts the selected cells into a table.

                

                	
                  Add a description (e.g., “Converts a cell range into a table and formats revenue as currency”).

                

                	
                  Click OK to start recording.

                

              

            

            	
              Click cell A2 on the second worksheet. Press Ctrl + T to open the Create Table dialog. 

              
                	
                  Ensure the “My table has headers” checkbox is checked. 

                

                	
                  Click OK to create the table.

                

              

            

            	
              Identify the column containing revenue (e.g., Total Revenue, column B) and manually select all the rows for that column in the table.

            

            	
              Go to the Home tab, and in the Number group, click the dropdown and select Currency. Adjust the currency symbol and decimal places using the Format Cells option if needed.

            

            	
              Go back to the Developer tab and click Stop Recording.

            

            	
              Save the workbook as a Macro-Enabled Workbook (.xlsm format) to retain the macro. You can find the file in the GitHub repository of the book under 04/sales_dataset_q5.xlsm.

            

          

          Figure 4-14 shows the result after recording the macro: the data is formatted as an Excel table, and the Total Revenue column is formatted as currency.
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            Figure 4-14. The data is formatted as an Excel table after recording the macro.

          

          If you were to apply the macro as it is to the other worksheets, though, you would get the wrong result, as shown in Figure 4-15. As you can see, only the first six rows have been converted into an Excel table, while the others have remained unchanged. This is because the macro was recorded considering a 6-row table. You don’t need to try this out yourself. It’s just to show you what would happen.

          
            
            Figure 4-15. If you apply the macro recorded for worksheet 2 to the other worksheets, you get an incorrect result because the macro records the specific values of the worksheet in question.

          

          To make the macro work correctly for other worksheets, you must generalize it, removing specific references to the data in worksheet 2. To do this, manually modify the macro code. ChatGPT helps us with this. You’ll use this procedure: open the VBA editor to access the macro, copy the macro code, paste it into ChatGPT, and instruct it to generalize. Follow these steps: 

          
            	
              Go to the Developer tab, click Macros, select ConvertToTable, and click Edit to open the VBA Editor.

            

            	
              Once the Editor VBA is opened, you will see the macro code in the module window (Figure 4-16).
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                Figure 4-16. The Editor VBA in Excel.

              

            

          

          Going into detail, recording the macro generated the following VBA code similar to this:

          Sub ConvertToTable()
'
' ConvertToTable Macro
' Converts a sheet into a table and formats revenue as currency
'
' Keyboard Shortcut: Ctrl+Shift+T
''
    Range("A2").Select
    Application.CutCopyMode = False
    ActiveSheet.ListObjects.Add(xlSrcRange, Range("$A$1:$B$6"), , xlYes).Name = _
        "Table2"
    Range("Table2[Total Revenue]").Select
    Selection.NumberFormat = "General"
    Selection.NumberFormat = "[$$-en-US]#,##0.00"
End Sub

          The macro defines the subroutine ConvertToTable using the keyword Sub. In VBA, subroutines are delimited by keywords Sub (to get started) and End Sub (to finish). In VBA, comments are identified by the apostrophe ('). Any text that follows an apostrophe in the same line is ignored by the compiler and is useful for documenting the code and improving its readability.

          After the comments header, the cell A2 is selected with this instruction:

          Range("A2").Select

          This selection selects the data to use. The next instruction is this:

          Application.CutCopyMode = False

          It turns off the mode cut/copy, preventing any copy/paste operations from interfering with the macro.

          At this point, the macro creates a table (ListObject) using this command:

          ActiveSheet.ListObjects.Add(xlSrcRange, Range("$A$1:$B$6"), , xlYes).Name = "Table2”

          This line converts the range A1:B6 in a table, assigning it the name Table2. The parameter xlYes indicates that the first row of the range contains column headings.

          To format the data correctly, the macro selects the entire column Total Revenue and formats it as currency:

          Range("Table2[Total Revenue]").Select
Selection.NumberFormat = "[$$-en-US]#,##0.00"

          Finally, the macro ends with the statement End Sub. 

          The macro as defined contains specific references to worksheet 2 (such as the range of cells in the table), so when it is applied to another sheet it does not produce the desired results. To fix this, you must generalize the macro. You can do this manually, or you can use ChatGPT. For best results, use the ChatGPT model optimized for reasoning (at the time of writing this chapter, this model is GPT-o1). To select a specific model in ChatGPT, log in to the web interface and click the name of the current template at the top left. A drop-down menu opens with all available model (Figure 4-17). Select the model for reasoning (GPT-o1 in my case).
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            Figure 4-17. The drop-down menu in the ChatGPT web interface allows you to choose the model to use.

          

          Now, ask ChatGPT to modify the VBA code by removing all specific references to the worksheet. Use the following prompt:

          Modify the following macro as follows: replace the specific sheet with the active sheet, replace the reference to the specific cells A1:B6 with all the nonempty cells, and don't set the name of the table: 
Sub ConvertToTable()
'
' ConvertToTable Macro
' Converts a sheet into a table and formats revenue as currency
'
' Keyboard Shortcut: Ctrl+Shift+T
''
    Range("A2").Select
    Application.CutCopyMode = False
    ActiveSheet.ListObjects.Add(xlSrcRange, Range("$A$1:$B$6"), , xlYes).Name = _
        "Table2"
    Range("Table2[Total Revenue]").Select
    Selection.NumberFormat = "General"
    Selection.NumberFormat = "[$$-en-US]#,##0.00"
End Sub

          ChatGPT returns a new macro code, also commenting on the points it changed. In my case, it produced the following code:

          Sub ConvertToTable()
    '
    ' ConvertToTable Macro
    ' Converts a sheet into a table and formats revenue as currency
    '
    ' Keyboard Shortcut: Ctrl+Shift+T
    '
    Dim ws As Worksheet
    Dim rng As Range
    
    ' Work with the active sheet
    Set ws = ActiveSheet
    
    ' Identify the range of all nonempty cells
    Set rng = ws.UsedRange
    
    ' Clear any copy/paste mode
    Application.CutCopyMode = False
    
    ' Create a table from the UsedRange. The table will have a default name.
    ws.ListObjects.Add(SourceType:=xlSrcRange, Source:=rng, XlListObjectHasHeaders:=xlYes)
    
    ' Format column B (2nd column) as currency
    ws.Columns("B:B").NumberFormat = "#,##0.00 $"
    
End Sub

          Replace the original code of the ConvertToTable macro inside the VBA Editor with the code generated by ChatGPT. If the VBA editor does not highlight any lines in red it means that the code does not contain errors. Otherwise, the code generated by ChatGPT is incorrect. In my case, ChatGPT generated a syntax error code, as shown in Figure 4-18.

          Warning

            If you replace the entire code, including the Sub and End Sub lines, you’ll need to manually put the keyboard shortcut back in. You’ll need to do this every time you replace the code. To restore the shortcut key, select Macros from the Developer tab. Then select the ConvertToTable macro and click Options. A new dialog box opens. Re-enter the shortcut key Ctrl+Shit+T and click OK. In the original dialog box, click Run if you want to run the macro or Cancel if you don’t want to run it.
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            Figure 4-18. The error highlighted by the VBA Editor.

          

          To resolve the error, continue the conversation with ChatGPT by typing the following prompt:

          Rewrite and optimize the code by fixing the following error: ' Create a table from the UsedRange. The table will have a default name. ws.ListObjects.Add(SourceType:=xlSrcRange, Source:=rng, XlListObjectHasHeaders:=xlYes)

          Replace the error with the specific error you got. ChatGPT generates a new version of the code. In my case, it generated the following code:

          Sub ConvertToTable()
    '
    ' ConvertToTable Macro
    ' Converts the active sheet's used range into a table
    ' and formats revenue as currency in Column B.
    ' Keyboard Shortcut: Ctrl+Shift+T
    '
    Dim ws As Worksheet
    Dim rng As Range
    
    ' Work with the active sheet
    Set ws = ActiveSheet
    
    ' Identify the range of all nonempty cells
    Set rng = ws.UsedRange
    
    ' Clear any copy/paste mode
    Application.CutCopyMode = False
    
    ' Create a table from the UsedRange. 
    ' By using HasHeaders:=xlYes, Excel will try to detect column headers automatically.
    ' The table will have a default name (e.g., Table1, Table2, etc.).
    ws.ListObjects.Add SourceType:=xlSrcRange, _
                       Source:=rng, _
                       HasHeaders:=xlYes
    
    ' Format column B as currency
    ws.Columns("B:B").NumberFormat = "#,##0.00 $"
End Sub

          Paste the code into the VBA Editor. In this case, it contains no syntax errors, so we can analyze it to see if it contains no conceptual errors. 

          ChatGPT eliminated the reference to specific cells, selecting all non-empty cells:

          ' Identify the range of all nonempty cells
    Set rng = ws.UsedRange

          Next, it removed the reference to the specific table name. Conceptually, the macro seems correct, so we can save it and apply it to the Sales Trends worksheet to see if it works.

          
            	
              Click the Sales Trends worksheet.

            

            	
              Select the Developer tab in the Ribbon and then Macros. 

            

            	
              Select the ConvertToTable macro and click Run.

            

          

          Running the macro, in my case, the VBA compiler gives the following error:

          Compile error: Named argument not found

          The error is related to the line of code:

          ws.ListObjects.Add SourceType:=xlSrcRange, _
                       Source:=rng, _
                       HasHeaders:=xlYes

          Use ChatGPT again to fix the problem. Continue the conversation by writing the following prompt containing the error generated by the compiler:

          I got this error: Compile error: Named argument not found.

          ChatGPT tries to fix the problem by generating a new code version. In my case, it generated the following code:

          Sub ConvertToTable()
    '
    ' ConvertToTable Macro
    ' Converts the active sheet's used range into a table
    ' and formats revenue as currency in Column B.
    ' Keyboard Shortcut: Ctrl+Shift+T
    '
    Dim ws As Worksheet
    Dim rng As Range
    
    ' Work with the active sheet
    Set ws = ActiveSheet
    
    ' Identify the range of all nonempty cells
    Set rng = ws.UsedRange
    
    ' Clear any copy/paste mode
    Application.CutCopyMode = False
    
    ' Create a table from the UsedRange using positional arguments:
    '   1. SourceType (xlSrcRange)
    '   2. Source (rng)
    '   3. LinkSource (omit or blank)
    '   4. XlListObjectHasHeaders (xlYes or xlNo)
    ws.ListObjects.Add xlSrcRange, rng, , xlYes
    
    ' Format column B as currency
    ws.Columns("B:B").NumberFormat = "#,##0.00 $"
End Sub

          Quickly check the generated code. Since everything looks correct, paste it into the VBA Editor and save it. Now, you are ready to apply the macro to a new worksheet. Follow the steps described below to apply the macro to the Sales Trends worksheet:

          
            	
              Select the Sales Trends worksheet.

            

            	
              Select Macros from the Developer tab.

            

            	
              Select the macro ConvertToTables in the dialog box.

            

            	
              Click Run.

            

          

          At this point, the data contained in the Sales Trends worksheet is correctly converted into a table and formatted as required. Reapply the macro to the other worksheets (except the Payment Methods worksheet, which does not contain monetary data).

          Tip

            Use ChatGPT not only to modify the code of an existing macro but also to generate and debug the code.)

          

          From the example described we can extract a general workflow (Figure 4-19) that you can always apply to generalize the macros you record.
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            Figure 4-19. The workflow to generalize the recorded macros.

          

          First record the macro, then copy the VBA code of the macro and ask ChatGPT to generalize the code, eliminating all parts that specifically refer to a particular worksheet. Quickly check if the code generated by ChatGPT is correct and test it in Excel. If there are problems, use ChatGPT to troubleshoot. Finally, run the macro.

          You can further generalize the workflow by directly asking ChatGPT to generate the macro in VBA, without recording it manually. Let’s see how to proceed in the next section.

        

        
          Using ChatGPT for Macro Generation

          In previous chapters you have seen the importance of defining the context to ensure that ChatGPT generates the correct result. You also saw that you can define the context in two ways:

          
            	
              Describe the structure of your dataset in words, specifying the name of the columns and possibly also the name of the Excel table, if the dataset is formatted as an Excel table.

            

            	
              Provide ChatGPT with the dataset (or a portion thereof) you want to operate on as input directly. This second option is faster but is less suitable if you are dealing with sensitive data.

            

          

          Even if you want to have ChatGTP generate macro code directly, you need to specify the context. As in the other cases, organize your conversation with ChatGPT in the form of a story: context, main part, and conclusions. The context contains the structure of your table, the main part the instructions for the macro, and the conclusions where you want to save the results of your macro. 

          Let’s take an example. Consider the dataset again 04/sales_dataset_q5.xlsx. Suppose you want to add a new worksheet to your workbook containing a weekly sales report for each product. Use the following prompt with context, main body, and conclusions to ask ChatGPT to generate a macro that creates the report:

          Consider an Excel table named MainTable representing sales, with the following columns: Transaction ID, 
  - Date of Sale, 
  - Product ID, 
  - Product Name, 
  - Quantity Sold, 
  - Unit Price, 
  - Total Sale Amount, 
  - Payment Method, 
  - Store Location, 
  - Customer Type. 

Write a VBA macro to analyze the dataset and generate a report on weekly sales for each product. 
  1. Group by Week and Product: Aggregate the data based on weeks and products, calculating the total sales.
  2. Create a New Report Sheet: Save the results in a new sheet named "Sales Report".
  3. Format the Report: Convert to a Table.

          Use ChatGPT’s advanced reasoning model (in my case, o1). ChatGPT generates the macro code and a short comment. In my case, ChatGPT generated quite an extended code, which you can find in the book’s GitHub repository at 04/create_weekly_sales_report_macro.txt. The VBA code analyzes the sales data in a list (ListObject) called MainTable in Excel, grouping them by week and by product. First, create or overwrite a new sheet called Sales Report. Then, use a dictionary (Scripting.Dictionary) to add the quantity sold and the total amount of each product, divided by week (calculated with the function WeekNum). Finally, write the results to the Sales Report sheet and convert them into a formatted table. 

          Add the macro to the Excel file as follows:

          
            	
              Click the Developer tab on the Ribbon, and in the Code group click Visual Basic.

            

            	
              In the Visual Basic Editor, look for the Project pane on the left (it lists all open workbooks and their objects). Right-click VBAProject (sales_dataset_q5.xlsx).

            

            	
              Select Insert → Module. A new blank module will appear in the code window (usually titled Module1 by default).

            

            	
              Paste the code generated by ChatGPT. Click Save if the file is already in the xlsm format. Otherwise, click Save As, give a name to your file, and choose Excel Macro Enabled Workbook as File Format. Also, close the VBA window.

            

          

          Run the macro by selecting Macros in the Developer tab and then followed by Run. A new worksheet named Sales Report is added to the workbook, as shown in Figure 4-20.

          
            
            Figure 4-20. The result obtained by applying the macro.

          

        

        
          Exercise 2

          Consider again the dataset 04/sales_dataset_q5.xlsx, write a prompt that solves the following problem: write a VBA macro that analyzes the dataset and automatically highlights high and low sales based on a user-defined threshold.

          You can find the solution in the book’s GitHub repository at 04/exercise3_prompt.txt.

        

      

      
        Conclusions on Part 1

        We have reached the end of this book’s first part, where you saw how to combine ChatGPT and Excel to improve efficiency in data analysis, process automation, and information management. We have explored different aspects of the integration between ChatGPT and Excel, each with its specifics and advantages.

        We began our journey with an overview of Excel’s role in data management, analysis, and visualization, highlighting how AI can enhance these capabilities. ChatGPT helps you reduce errors, speed up repetitive tasks, and improve productivity, especially for those working with large amounts of data. Subsequently, you learned how to interact with ChatGPT to obtain effective responses using prompt engineering techniques. You’ve seen how to structure a conversation with ChatGPT to get formulas, functions, and practical tips to improve your daily Excel work. Then you learned how ChatGPT can simplify and automate recurring tasks in Excel, such as entering and formatting data, calculating key metrics, and creating custom reports. Finally, you explored advanced features, such as using ChatGPT to generate complex formulas, analyze datasets, create graphs, and even write VBA macros. You have seen how ChatGPT can support you in debugging and optimizing code, improving the quality of analyses and decision-making processes.

        Part 1 of this book provided a solid foundation on leveraging ChatGPT to enhance the use of Excel, automating repetitive tasks and making analyses faster and more intuitive. Part 2 focuses on Copilot, another powerful AI integration with Excel, which offers even more advanced tools for analyzing and managing data.

        I want to conclude my thoughts about Part 1 with a personal reflection. ChatGPT is a powerful tool capable of speeding up work and simplifying many tasks. But there is a real risk that it will make us unaccustomed to reasoning, learning, and questioning information. How many times do we take what it suggests to us as good without stopping to verify it?

        That already happened to me with some data journalism students who had entrusted their project to a developer, paying him handsomely. The result? Impeccable work, but they hadn’t learned anything. They couldn’t explain how it worked; in the end, their project wasn’t theirs. In addition, they couldn’t then apply what they would have learned elsewhere, so the problem goes beyond the actual project.

        The same happens with ChatGPT. We can use it to generate code, write texts, or solve problems, but if we don’t take the time to verify, understand, and reason, we risk becoming just passive executors, incapable of truly growing.

        Let’s not let convenience turn into laziness, or let laziness translate into a loss of quality. ChatGPT should be an ally, not a substitute for critical thinking. For this reason, my advice is always the same: check, experiment, question. Only in this way can we make the best use of technology without stopping learning.

      

      
        Summary

        In this chapter, you learned how to use ChatGPT to analyze a dataset, define macros, and write VBA code.

        
          	
            ChatGPT helps you speed up data analysis in Excel by automatically identifying dataset categories, suggesting relevant questions, and generating advanced formulas to extract insights more effectively.

          

          	
            Following a structured workflow, you can load a dataset, obtain key questions, generate answers via Excel formulas, and implement them directly in the file, automating complex operations without advanced programming knowledge.

          

          	
            Using ChatGPT for VBA macros allows you to create, generalize, and fix code efficiently, reducing errors and making repetitive tasks faster and more customizable to specific spreadsheet needs.

          

          	
            Through automation with macros and VBA, you can generate weekly reports, format data dynamically, and highlight key information, improving data organization and analysis with a more structured and automated approach.

          

        

      

      
        Activity

        Solve the crossword puzzle shown in Figure 4-21. The answer is given in Appendix A.

        
          [image: A crossword puzzle with numbers  AI-generated content may be incorrect.]
          Figure 4-21. Crossword to solve

        

        
          Across

          
            	
              1 - A type of table in Excel used to summarize and analyze data dynamically.

            

            	
              4 - Raw facts and numbers that can be analyzed or processed in a spreadsheet.

            

            	
              6 - Technology that enables machines to simulate human intelligence and decision-making.

            

            	
              7 - Widely used spreadsheet software developed by Microsoft.

            

          

        

        
          Down

          
            	
              2 - A programming language used in Excel to automate tasks and create macros.

            

            	
              3 - Transactions where goods or services are exchanged for money.

            

            	
              5 - A structured arrangement of data in rows and columns within a spreadsheet.

            

          

        

      

    



      Chapter 5. Getting Started with Copilot

      
A Note for Early Release Readers


With Early Release ebooks, you get books in their earliest form—the author’s raw and unedited content as they write—so you can take advantage of these technologies long before the official release of these titles.


This will be the 5th chapter of the final book. Please note that the GitHub repo will be made active later on.


If you have comments about how we might improve the content and/or examples in this book, or if you notice missing material within this chapter, please reach out to the editor at ccollins@oreilly.com.



      One morning, after breakfast, my children and I gathered a few leftover cookie crumbs and brought them out to the garden, near a spot where we had often seen ants passing by. We placed the crumbs down one at a time, deliberately, curious to see what would happen. Within minutes, the first ants began to appear. Quietly and methodically, each one took on a task: some collected, others carried, and a few seemed to organize the flow. Not a single crumb was wasted. In no time, everything had been neatly picked up and taken away, with remarkable precision. That simple moment reminded me of how Copilot in Excel works. It doesn’t require a grand gesture or a perfect setup. Instead, it responds best when you offer it a little at a time. A question. A column. A hint of what you’re trying to achieve. You don’t need to know everything up front: you just need to start.

      Copilot gathers the pieces you provide, connects them, analyzes them, and builds valuable insights, step by step. One crumb at a time, it helps you sort, visualize, and make sense of your data. It doesn’t replace your judgment, but it frees you from repetitive tasks so you can focus on what matters most: understanding and decision-making.

      In this chapter, we’ll explore how to get started with Copilot in Excel, from enabling it in your environment to using its first key features for creating, editing, and understanding your data in an intuitive and guided way. To begin, you don’t need much, just a willingness to offer the first crumb. 

      More specifically, this chapter covers the following:

      
        	
          Introducing and enabling Copilot in Excel

        

        	
          Creating

        

        	
          Editing

        

        	
          Understanding

        

      

      Let’s start with introducing and enabling Copilot in Excel.

      
        Introducing and Enabling Copilot in Excel

        Microsoft Copilot in Excel is an AI-driven assistant for managing spreadsheets. You can use Copilot to analyze data, suggest formulas, automate repetitive tasks, and build visualizations. 

        Before using Copilot in Excel, ensure that you can access Microsoft 365 with Copilot enabled. If you have a Microsoft 365 Business or Teams subscription, ask your administrator to activate Copilot. If you have a Microsoft 365 Personal subscription, you must activate the Microsoft Copilot Pro subscription. The cost of the Copilot subscription is not part of the Microsoft 365 subscription. The procedure to activate Copilot, along with its updated costs, is available on the Microsoft dedicated page (at the time of writing, it’s $20 per month).

        Warning

          If you only activate Microsoft Copilot Pro without an additional Microsoft 365 subscription, you can only use Copilot in the Excel web application. You can also use Copilot in the Excel desktop application if both subscriptions are active.

        

        Once you have access to Microsoft Copilot, the Copilot icon should appear directly in the Ribbon Home tab. To check if it is enabled, launch Excel and verify the presence of the icon, as shown in Figure 5-1.

        
          
          Figure 5-1. The Copilot icon in the Home Ribbon.

        

        Click the Copilot icon to access the Copilot panel (Figure 5-2). Note that Copilot works only on files saved on OneDrive.

        
          [image: A screenshot of a cell phone  AI-generated content may be incorrect.]
          Figure 5-2. The Copilot panel.

        

        Warning

          It may happen that the first time you launch Copilot, It only displays the message “I only work with files that have AutoSave turned on. Turn it on to continue.” It then prompts you to add the file to OneDrive.

        

        The Copilot panel offers various options, which can vary from run to run at the time of writing. Possible options include “How do I?”, “Suggest a column”, “Add a color scale to a column”, “Split columns”, and so on. Click one of the proposed options to access the related feature. Alternatively, write your question directly in the chat box. 

        Now that your Copilot assistant is installed and working, let’s use it to perform some basic operations, including creating, editing, and understanding:

        
          	Creating

          	
            Generate new content, such as PivotTables or charts

          

          	Editing

          	
            Modify or refine existing data, formulas, or tables

          

          	Understanding

          	
            Provide insights, summaries, and explanations to help interpret information.

          

        

        The create, edit, and understand operations encompass the most common methods for interacting with your data. Let’s dive in and see what these categories can help you do. We will use the dataset Persons reading books in the last 12 months by sex, age, educational attainment, and number of books (ilc_scp27) provided by Eurostat under the CC BY 4.0 license and available in the GitHub repository as 05/reading_habits.xlsx.

        Table 5-1 shows an extract of the dataset.

        
          Table 5-1. An extract of the reading habits dataset.
          
            
              	freq
              	n_book
              	isced11
              	sex
              	age
              	unit
              	geo\TIME_PERIOD
              	2022
            

          
          
            
              	A
              	0
              	ED0-2
              	F
              	Y16-24
              	PC
              	AT
              	23.5
            

            
              	A
              	0
              	ED0-2
              	F
              	Y16-24
              	PC
              	BE
              	28.1
            

            
              	A
              	0
              	ED0-2
              	F
              	Y16-24
              	PC
              	BG
              	61.9
            

            
              	A
              	0
              	ED0-2
              	F
              	Y16-24
              	PC
              	CH
              	10.6
            

            
              	A
              	0
              	ED0-2
              	F
              	Y16-24
              	PC
              	CY
              	75.7
            

            
              	A
              	0
              	ED0-2
              	F
              	Y16-24
              	PC
              	CZ
              	12.7
            

            
              	A
              	0
              	ED0-2
              	F
              	Y16-24
              	PC
              	DE
              	: u
            

            
              	A
              	0
              	ED0-2
              	F
              	Y16-24
              	PC
              	DK
              	20.2
            

            
              	A
              	0
              	ED0-2
              	F
              	Y16-24
              	PC
              	EA20
              	33.6 e
            

            
              	A
              	0
              	ED0-2
              	F
              	Y16-24
              	PC
              	EE
              	14.2
            

          
        

        The dataset provided by Eurostat refers to the number of people who read books in the past 12 months, broken down by various demographic and educational characteristics. The dataset contains the following columns:

        
          	freq

          	
            Frequency of the data collection. In this case, it is always A, corresponding to annual data.

          

          	n_book

          	
            Number of books read. Possible values include 0, LT5 (less than 5), 5-9, and GT10 (Greater than 10).

          

          	isced11

          	
            Level of education according to the ISCED 2011 classification. Possible values include: ED0-2 (low education level, e.g., primary school or less), ED3_4 (Secondary education), ED5-8 (Tertiary education, e.g., university or postgraduate).

          

          	sex

          	
            Sex. Possible values include F (female), M (male), T (total).

          

          	age

          	
            Age group. Examples of values include Y16-24 (16-24 years old), Y25-34 (25-34 years old), and Y_GE65 (65 years old and over).

          

          	unit

          	
            Unit of measurement. PC stands for percentage.

          

          	geo\TIME_PERIOD

          	
            Country or geographical area. For example: AT: Austria, BE: Belgium, EU27_2020: European Union (27 countries, as of 2020).

          

          	2022

          	
            Percentage of people who read books in the past 12 months 2022, based on demographic and educational characteristics.

          

        

        You are now ready to use Copilot with this dataset. Let’s start by creating something new with Copilot. For all the examples, I’ll use the Web version of Excel with only the Copilot subscription active (no Microsoft 365 subscription). However, if you use a different version, you should not experience differences.

      

      
        Creating

        When you use Copilot to create, you’re making something new, such as a PivotTable. In this section, we’ll focus on creating PivotTables and column charts. 

        
          PivotTable

          Consider the book habits dataset. We’ll use Copilot to quickly generate a PivotTable that shows how book-reading behavior varies across different education levels. Proceed as follows:

          
            	
              Open the book habits dataset available on GitHub 05/reading_habits.xlsx in Excel. The dataset consists of a single sheet with a single table. Click anywhere in the table (such as cell A2).

            

            	
              Click the Copilot button in the Ribbon. In the Chat box, write the following prompt in natural language and then click the Send button or press the Enter/Return key:

            

            	
              Create a PivotTable that shows the average percentage of people who read books, with education level as rows and the number of books read as columns.

            

          

          Figure 5-3 shows the output generated by Copilot in my case. The output appears in the Copilot panel.

          
            
            Figure 5-3. The output generated by Copilot after asking to generate a PivotTable

          

          The answer generated by Copilot is structured in three parts:

          
            	
              The PivotTable displays education levels (ED0-2, ED3-4, ED5-8) as rows, with categories of books read (0, 5-9,> 10, < 5) as columns, accompanied by grand totals for each category. Below the PivotTable, a button labeled “+ Add to a new sheet” provides a quick option to integrate the generated table directly into your Excel workbook.

            

            	
              A short description of the insights extracted from the data.

            

            	
              A suggestion of some possible follow-up questions, such as: Which is the 'sex' for 'age', 'Y16-24'?, How many 'geo\TIME_PERIOD' of 'AT'?, and Are there any outliers in my data?"

              
                	
                  Click “+ Add to a new sheet” to add the generated PivotTable to a new worksheet. Figure 5-4 shows the resulting PivotTable.

                  
                    
                    Figure 5-4. The PivotTable generated by Copilot.

                  

                  Reviewing the generated output, Copilot has correctly calculated the average value for each column except for the Grand Total. This column should calculate the total percentage and not the average value. Since the Grand Total value should always be 100%, we can remove this column. You have to proceed manually because Copilot can’t currently edit PivotTables for you. Proceed as follows:

                

              

            

          

          
            	
              Select the cell corresponding to Grand Total (cell F3).

            

            	
              Right-click the cell.

            

            	
              Select Remove Grand Total (Figure 5-5).

              
                
                Figure 5-5. The procedure to remove the Grand Total column.

              

            

          

        

        
          Column Chart

          Let’s now use Copilot to create a column chart showing the reading habits for ED3_4 (secondary education). To draw the column chart correctly, we must prepare the data before asking Copilot to generate the chart. 

          Follow the steps described below to let Copilot generate a new column chart for ED3_4:

          
            	
              Filter the data to display only information related to ED3_4. Right-click the dropdown arrow near the isced11 header and from the dropdown menu, keep selected only ED3_4 by deselecting the other options (Figure 5-6).

              
                
                Figure 5-6. The dropdown menu for the isced11 column.

              

            

            	
              The filter is now enabled and identified through a small symbol near the header isced11 (Figure 5-7).

              
                [image: A screenshot of a computer  AI-generated content may be incorrect.]
                Figure 5-7. The PivotTable with the filter enabled for the isced11 column.

              

            

            	
              To build the column chart, columns B, C, D, and E must appear as rows of a table, otherwise, the chart will draw them as different series. For this reason, we must transpose the table and convert columns to rows:

              
                	
                  Select all the PivoTable values manually, or click Ctrl+A (or Cmd+A for MacOS). 

                

                	
                  Right-click the selected items and click Copy from the dropdown menu. Alternatively, click Ctrl+C.

                

                	
                  Add a new sheet by clicking the + button near the current sheet name. Move to the new sheet.

                

                	
                  Open the Paste menu from the Home tab of the Ribbon, and in the dropdown menu, click Transpose Rows and Columns (or simply Transpose). Figure 5-8 shows the resulting range.

                  
                    
                    Figure 5-8. The transposed table.

                  

                

              

            

            	
              Now you are ready to ask Copilot to draw the column chart. Write the following prompt in the Copilot chat box:

              Draw a column chart ordered by decreasing ED3_4.

              Figure 5-9 shows the output generated by Copilot.

              
                
                Figure 5-9. The column chart generated by Copilot.

              

            

            	
              Click “+ Add to a new sheet” in the Copilot answer to add the column chart in a new sheet. Figure 5-10 shows the final result, featuring a new PivotTable on the left and a column chart on the right side of the sheet. 

              
                
                Figure 5-10. The PivotTable and column chart generated by Copilot.

              

            

          

          Warning

            Sometimes, Copilot may not generate the correct answer immediately, but it could provide an answer similar to the following one:

            I encountered an issue while trying to draw the column chart. You can manually create a column chart by selecting the data in the pivot table and using the "Insert" tab to choose a column chart type.

            Copilot could also generate an answer similar to the following one:

            Something went wrong. Please try again in a moment.

            Simply rewrite the prompt to solve this problem and make Copilot generate the correct answer.

          

        

        
          Exercise 1

          Consider again the reading habits dataset. Write the prompt for Copilot to create a PivotTable showing the average percentage of people who read books, with age group as rows and the number of books read as columns. Figure 5-11 shows the resulting PivotTable.

          
            
            Figure 5-11. The resulting PivotTable.

          

          You can find a possible prompt for Copilot in GitHub under 05/exercise1_solution.txt.

          Tip

            Just like a vine that quietly grows and, over time, produces clusters of grapes, the process of creating with Copilot begins with something small and simple. You plant an idea, such as a prompt, a question, or a need, and let the system guide its growth. From that single start, you may generate insights, visualizations, or new ways of looking at your data that you hadn’t considered before. The beauty lies not in complexity, but in the natural flow of creation that Copilot supports.

          

          Now that we’ve explored what it means to create with Copilot, let’s move to editing.

        

      

      
        Editing

        In this section, you will see how to perform basic editing operations on a spreadsheet using Copilot: renaming column headers and splitting a column into two. These basic operations are meant to whet your appetite for learning more about how to perform other operations using Copilot. Later in the book, you will encounter additional operations, including data cleaning and preparation.

        Let’s start with renaming columns. 

        
          Renaming a Column

          I have often worked with datasets that have columns with difficult names to remember, such as acronyms or code names. Renaming these columns helped me work better. Sometimes, however, I couldn’t find the right name for the columns. At other times, I didn’t have time to think of sensible names, so I continued to work with acronyms and incomprehensible names, which increased the processing and analysis time. 

          To solve this problem, I found great help in Copilot. Consider the dataset related to reading habits once again. Select a cell in the original table, start Copilot, and type the following prompt in the Copilot chat box:

          Propose alternative column headers so that they reflect the column content.

          Copilot generates alternative column headers, like those shown in Figure 5-12.

          
            
            Figure 5-12. The alternative column names proposed by Copilot.

          

          Unfortunately, at the time of writing, Copilot cannot automatically replace the generated column names with the proposed ones. This operation must be done manually. So, replace the existing column names with the proposed column names by simply writing the proposed column names in the corresponding column headers. Figure 5-13 shows the resulting table.

          
            
            Figure 5-13. The resulting PivotTable.

          

          Tip

            You can also use this technique to translate column names into another language. For example, use the following prompt:

            Propose a translation into Italian of the column names.

          

          In this case, Copilot proposes the translation of the column headers into Italian:

          
            	
              
                Frequency: Frequenza
              

            

            	
              
                Book Count: Conteggio dei libri
              

            

            	
              
                Education Level: Livello di istruzione
              

            

            	
              
                Gender: Genere
              

            

            	
              
                Age Group: Gruppo di età
              

            

            	
              
                Unit: Unità
              

            

            	
              
                Geographical Area: Area geografica
              

            

            	
              
                Value for 2022: Valore per il 2022
              

            

            	
              
                First age: Prima età
              

            

            	
              
                Last age: Ultima età
              

            

          

        

        
          Splitting a Column

          Splitting means dividing a column into two or more columns based on one or more criteria. For example, you can split a column containing the first and last name of a person into two columns, one for the first name and one for the last name. Considering again the dataset on reading habits, select the cell in the original table (where you also renamed the column headers), and type the following prompt in the Copilot chat box:

          Extract the first and last age in the Age Group column and insert them into two new columns.

          The prompt asks Copilot to split the Age Group column into two columns, one for the first age and one for the last age. In my case, Copilot generated two outputs, one for each new column:

          Extracts the first age from the age group by taking the part before the hyphen. This helps in identifying the starting age of each age group in the table.
=TEXTBEFORE([@[Age Group]],"-")
 
Extracts the last age from the "Age Group" column by taking the text after the hyphen. This helps to identify the upper limit of the age range for each entry in the table.
=TEXTAFTER([@[Age Group]],"-")

          Each explanation is accompanied by the specific formula to use to extract the part of the text to insert into the column.

          Tip

            Next to each formula, Copilot also displays the “Show explanation” option (Figure 5-14), which displays details about the formula.

          

          
            
            Figure 5-14. The “Show explanation” option.

          

          Tip

            For example, clicking the “Show explanation” option below the formula for the last Age column produces output similar to this:

            Extracts the last age from the "Age Group" column in the table by using the following steps:
Uses the TEXTAFTER function to find the text that appears after the hyphen ("-") in the "Age Group" column value.

          

          In addition to the formulas that generate the new columns, Copilot also displays a preview of the result columns in the chat box (Figure 5-15).

          
            
            Figure 5-15. A preview of the calculated columns in the Copilot chat box.

          

          The first column contains a slight inaccuracy: the letter Y (which stands for Year) is before the actual age. This value is not good, so we ask Copilot to remove it using the following prompt:

          Modify the following formula to exclude the starting Y: =TEXTBEFORE([@[Age Group]],"-") and recalculate the 2 new columns to insert

          Copilot responds by modifying the original formula. In my case it generated the following output:

          =TEXTBEFORE(TEXTAFTER([@[Age Group]],"Y"),"-")
 

          In addition to changing the formula, Copilot once again lets you preview the table (Figure 5-16), this time without the leading Y in the First age column.

          
            
            Figure 5-16. A preview of the modified table.

          

          Now, click the “+ Insert columns” button below the table preview in the Copilot chat box. Copilot automatically adds the new columns to the original table, as shown in Figure 5-17.

          
            
            Figure 5-17. The resulting table with the two new columns.

          

        

        
          Exercise 2

          Write the prompt to extract the first and last level in the Education Level column and insert them into two new columns. If the Education Level is TOTAL, ask Copilot to write 0 in the first level column and 8 in the last level. Figure 5-18 shows the resulting table.

          
            
            Figure 5-18. The resulting table.

          

          You can find a possible prompt for Copilot in GitHub under 05/exercise2_solution.txt. If Copilot only calculates the First level column, type the following extra prompt:

          Now add the Last level column.

          Tip

            To understand what editing is, consider water. Water’s essence doesn’t change, but when poured into a glass, a bottle, or a riverbed, it takes on a different shape each time. The same is true for data. The raw content remains the same, but when you edit and reshape it, by renaming, splitting, or organizing columns, you begin to see it in a new form. Editing is about preparing the container, setting the stage for meaning to emerge. After preparing the container, it’s time to go deeper. In the next section, you’ll explore how to use Copilot to understand the data—not just what it says, but what it means.

          

        

      

      
        Understanding

        Once your data looks good, it’s time to ask the real questions. Who reads more books, males or females? What age group reads the most? How has reading changed over time? In this section, you’ll see the default strategy provided by Copilot to understand data. In the following chapters, you’ll delve into more advanced techniques that will help you to extract meaning from data.

        When you launch Copilot from the Home tab of the Ribbon, Copilot provides some default options you can use to explore your data quickly. Among the default options is “Show data insights.” If you don’t see this option immediately, click More Examples in the Copilot chat box until this option appears. This option also appears in the chatbox while you are working on a specific table, as shown in Figure 5-19. If you don’t see More Examples, but there’s a Refresh button, click next to the suggestions.

        
          
          Figure 5-19. The “Show data insights” button in the Copilot chat box.

        

        Let’s use an example to show how this option works:

        
          	
            Consider the reading habits dataset again and select the worksheet where you added the First and Last age columns.

          

          	
            Click the “Show data insights” button in Copilot. Copilot will calculate the frequency of values for a specific column, as shown in Figure 5-20.

            
              
              Figure 5-20. The chart generated by Copilot when clicking the “Show data insights” button.

            

            Additionally, Copilot generates a text summary of relevant information related to the calculated insight. In my case, Copilot wrote the following text:

            The data insights show the count of 'Frequency' by 'Last age'. For example, the count for 'Last age' 64 is 6528, and for age '54' is 3264. See the table above for more details.

          

          	
            Click the “Add to a new sheet” button to add the calculated insight to a new worksheet. Figure 5-21 shows the resulting sheet, with the generated PivotTable and the bar chart.

            
              
              Figure 5-21. The new worksheet generated by Copilot, containing the extracted insight.

            

            Tip

              An insight is a valuable piece of information extracted from data. An insight differs from data in that data is a raw piece of information collected from a source, whereas an insight is the meaning extracted from the data. For example, 3 million followers is data; 3 million followers more than last year is an insight.

            

          

          	
            Once you have completed the elaboration of an insight, Copilot offers two new buttons: “Can I see another insight?” and “Add all insights to grid”, as shown in Figure 5-22. If you don’t have the original data selected, you could see the buttons “Go back to data” and “Undo”. Click the first button to go back to the table data.

            
              
              Figure 5-22. The two buttons provided by Copilot after elaborating the first insight.

            

          

          	
            Click the button “Can I see another insight?” Copilot will follow the same procedure as in the previous case and will calculate another insight. In my case, it calculated the Frequency by First age and Gender, as shown in Figure 5-23.

            
              
              Figure 5-23. The result of clicking “Can I see another insight?”

            

          

          	
            Click the “Add to a new sheet” button if you want to add this insight to your workbook.

          

        

        Warning

          When using the web version of Excel, it may happen that your browser settings prevent some operations required by Copilot. In this case, a message similar to the one shown in Figure 5-24 can appear in the Copilot chat box. To solve the problem, simply click the Verify button in the Copilot chat box.

        

        
          
          Figure 5-24. The Verify button in the Copilot chat box.

        

        
          Exercise 3

          Select the first worksheet of the reading habits dataset and click the “Add all insights to grid” button in Copilot (Figure 5-22). Describe what Copilot suggests. You should obtain something similar to Figure 5-25.

          
            
            Figure 5-25. A possible output after clicking the “Add all insights to grid” button in the Copilot chat box.

          

          Tip

            In some cases, the “Add all insights to grid” button doesn’t appear. If it doesn’t appear, follow the steps described below:

            Type the prompt Add all insights to grid

            Copilot usually tells you it can’t do that, but shows the suggestion “Add all insights to grid”

             Clicking on the suggestion then adds the insights.

          

          In this particular example, the insights provided by Copilot’s default analysis are not especially impressive. However, in other situations, they can serve as a helpful starting point for exploring a dataset. Starting in the next chapter, you’ll see more advanced techniques to use Copilot to prepare and analyze data, starting with data preparation.

          
            Yes, You Can Catch the Butterfly

            We’ve reached the end of this introductory chapter on Copilot, and depending on how things went for you, you might be feeling either excited or a bit discouraged. Honestly, over the past few days, I’ve felt a bit disheartened while using Copilot, and I’d like to share with you why.

            As I write this, I’m tucked away in the mountains, spending some time with my family. It’s peaceful and beautiful, but the internet connection? Not so great. It’s slow, and sometimes it cuts out completely. And here’s the thing: Copilot requires a stable internet connection to function correctly. In my case, that means I have to retry commands multiple times before getting any helpful response. It’s not Copilot’s fault; it’s the connection. But still, it’s frustrating. And yeah, there have been moments when I’ve felt like giving up. You might be feeling the same. Maybe you’re thinking, “Ugh, let’s just go back to the old ways and toss this book (and Copilot) out the window.”

            But before you do, let me tell you a little story. Yesterday, my son Antonio was running through a meadow, chasing a stunning, rare blue butterfly. I asked him, “What are you doing, Antonio?” And he said, “I’m going to catch it!” I laughed and told him, “That’s impossible!” But he looked at me and said, “No, I can do it.”

            And I watched him: again and again, he ran and chased and reached and missed. But then, all of a sudden, he came sprinting toward me, beaming: “Mom, look!” In his little hand was the butterfly, fluttering. He showed it to me with pride, and then gently placed it on a flower and let it go.

            What a powerful lesson from a six-year-old.

            The same applies to Copilot and the use of Generative AI in general: don’t give up at the first obstacle. Keep going. Keep trying. Be curious. Be persistent. And I promise, the magic will start to happen, little by little.

          

        

      

      
        Summary

        In this chapter, you learned how to use Microsoft Copilot within Excel for three simple tasks: creating, editing, and understanding. 

        
          	
            Copilot helps you simplify data tasks in Excel by allowing you to interact with spreadsheets through natural language. Whether you’re generating a PivotTable, building a chart, or exploring your data, Copilot guides you through the process of creating, editing, and understanding data, and suggests relevant actions.

          

          	
            Use Copilot to create PivotTables and visualizations such as column charts, and suggest or translate column names.

          

          	
            Copilot can analyze your table and offer key insights, including charts and summaries. With options like “Show Data Insights” and “Add All Insights to Grid,” you can explore your data with just a few clicks and uncover patterns effortlessly.

          

          	
            While Copilot still has some limitations (for example, the inability to rename headers or potential issues with browser compatibility), its intuitive interface and ability to answer natural language prompts make it a valuable partner for data exploration and automation. Copilot is constantly improving. Features that weren’t there in the early days are now available.

          

        

        In this chapter, you got your first taste of what Copilot can do. But we’re just getting started. In the next chapter, you’ll learn how to harness Copilot to prepare your data like a pro, including removing duplicates, handling missing values, and applying clean, consistent formatting. Get ready to unlock the full potential of your dataset.

      

      
        Activity

        Solve the crossword puzzle in Figure 5-26. After completing it, you’ll read the word used to indicate something valuable extracted from data. The solution is in Appendix A.

        
          [image: A crossword puzzle with numbers  AI-generated content may be incorrect.]
          Figure 5-26. Crossword puzzle to reveal the word used to indicate something valuable extracted from data

        

        Definitions:

        
          	
            The process of modifying existing data within a worksheet, such as renaming columns, splitting cells, or cleaning up labels.

          

          	
            The process of interpreting data with the help of Copilot’s analysis features, like “Show Data Insights.” It involves generating summaries, visualizations, and key patterns that help users make sense of the information.

          

          	
            A formatting function often used before creating charts, where the orientation of data is switched from rows to columns or vice versa.

          

          	
            A specific editing task where Copilot is asked to divide a single column (e.g., age range or education level) into multiple columns using functions like TEXTBEFORE() and TEXTAFTER(), thereby helping to structure the data more effectively.

          

          	
            A visual representation of data used to show relationships, trends, or comparisons between values.

          

          	
            The title of a column in a dataset.

          

          	
            The process of using Copilot to generate new elements in a worksheet, such as PivotTables or column charts, based on user prompts.

          

        

      

    



      Chapter 6. Data Preparation with Copilot

      
A Note for Early Release Readers


With Early Release ebooks, you get books in their earliest form—the author’s raw and unedited content as they write—so you can take advantage of these technologies long before the official release of these titles.


This will be the 5th chapter of the final book. Please note that the GitHub repo will be made active later on.


If you have comments about how we might improve the content and/or examples in this book, or if you notice missing material within this chapter, please reach out to the editor at ccollins@oreilly.com.



      Many years ago, I found myself tackling a predictive modeling project for the very first time. The goal was to forecast ship routes as part of a project funded by the European Space Agency (ESA). It was also my first real encounter with massive datasets concerning historical ship route data. The dataset comprised approximately 80 million records, provided by two different providers. At the time, that number felt enormous to me. This was also my first hands-on experience building a real-world machine learning model.

      I still vividly remember the first version of the model I built. I trained the model using approximately 20 million records and then tested it on the remaining 60 million records. The result was a complete disaster.

      First off, the training process took over a month. But that wasn’t the worst part; the model’s predictions were totally off. It just couldn’t get the ship routes right. But I didn’t give up. I decided to take a deep dive into the data, examining it in fine detail to gain a deeper understanding of what was really going on. That’s when everything started to make sense. I realized that the two data providers had given me almost identical data, so nearly every record was duplicated. In other words, I didn’t actually have 80 million records. I had more like 40 million. Then I noticed other issues: misformatted numbers, missing values, fields that had been interpreted as text instead of numeric values… the list went on.

      So, I rolled up my sleeves and got to work, meticulously cleaning and preparing the dataset. After all the cleaning, I was left with around 4 million solid records. I used those to train a new version of the model, and this time, it actually worked. It became fairly accurate at predicting ship routes.

      That experience taught me a valuable lesson: before diving into any kind of data analysis, the data needs to be properly prepared and cleaned. And that’s exactly what this chapter is all about: getting your data ready for action.

      More specifically, this chapter covers three techniques for data preparation:

      
        	
          Removing duplicates

        

        	
          Dealing with missing values

        

        	
          Data formatting

        

      

      Let’s start with the first step, introducing data preparation.

      
        Removing Duplicates

        Duplicates in a dataset are records that appear more than once and contain identical values in across all the columns. These repetitions can occur due to manual data entry errors, system imports, or inconsistent data collection processes.

        While duplicates may seem harmless at first glance, they can significantly degrade the quality and reliability of your data analysis because they can:

        
          	Skew summary statistics and totals

          	
            Duplicates can artificially inflate metrics such as counts, sums, averages, and percentages. For example, if a Sale ID appears twice by mistake, total revenue figures may be overestimated, and average sales per transaction may appear higher than they actually are.

          

          	Lead to inaccurate insights

          	
            Duplicates can distort trends, introduce noise into predictive models, and bias results. For instance, customer segmentation based on transaction frequency may incorrectly categorize clients if duplicate entries exaggerate their activity.

          

          	Complicate data analysis

          	
            Analysts often rely on the uniqueness of certain identifiers (like Sale ID) to join tables or group data. Duplicates in these fields can lead to incorrect joins, mismatches, or ambiguous aggregations. 

          

        

        Therefore, you should remove duplicates to maintain the integrity of your dataset and the trustworthiness of your results. Let’s see how Copilot can help us in this task.

        Consider the dataset related to some sample product sales, which is available in the book’s GitHub repository under 06/product_sales.xlsx (Figure 6-1). 

        
          [image: A screenshot of a spreadsheet  AI-generated content may be incorrect.]
          Figure 6-1. The product sales dataset.

        

        Each row describes a transaction. The columns of the dataset are:

        
          	Sale ID

          	
            Unique identifier for the sales transaction (e.g., 1001, 1002, etc.)

          

          	Date

          	
            Date of the transaction

          

          	Product Name

          	
            Name of the product sold (e.g., “Laptop”, “Mouse”, “Monitor”)

          

          	Quantity

          	
            Number of units of the product sold in the transaction

          

          	Price

          	
            Unit price of the product

          

          	Total

          	
            Total amount of the sale

          

          	Salesperson

          	
            Name of the salesperson who made the sale.

          

          	Branch Location

          	
            Branch where the sale occurred (e.g., “New York”, “Chicago”, “Los Angeles”).

          

        

        Let’s use Copilot to check if the dataset contains duplicates. Open the Copilot chat by clicking the related button in the Ribbon, as explained in the previous chapter. Then, write the following prompt in the chat:

        Highlight duplicates in the column Sale ID

        In most cases, Copilot should provide an answer similar to the one shown in Figure 6-2.

        
          [image: A screenshot of a chat  AI-generated content may be incorrect.]
          Figure 6-2. The answer provided by Copilot after asking to highlight duplicates.

        

         In practice, Copilot asks to apply a conditional formatting rule for duplicate records. Click the Apply button in the Copilot chat. Figure 6-3 shows the result after clicking the Apply button. 

        
          [image: A screenshot of a spreadsheet  AI-generated content may be incorrect.]
          Figure 6-3. The dataset with the highlighted duplicate rows for the Sale ID column.

        

        The dataset contains just one duplicate row. Let’s ask Copilot to remove it through the following prompt:

        Remove duplicate entries

        At the time of writing, Copilot can’t remove duplicates directly. Instead, it suggests the steps to remove duplicates using the tools provided by Excel. In my case, Copilot has provided the following answer:

        I can't help with this.
To remove duplicate entries in the "Sale ID" column of the table "Table1," follow these steps:

Select the entire table or the "Sale ID" column.
Go to the Data tab on the ribbon.
Click Remove Duplicates in the "Data Tools" group.
In the dialog box, ensure "Sale ID" is checked (or any other columns you want to consider for duplicates).
Click OK to remove duplicates.
This will remove rows with duplicate "Sale ID" values while keeping the first occurrence.

        Follow the steps proposed by Copilot. Specifically, when you click Remove Duplicates in the Data Tools group, the dialog box shown in Figure 6-4 appears. Select only Sale ID and click OK.

        
          [image: A screenshot of a computer  AI-generated content may be incorrect.]
          Figure 6-4. The dialog box to remove duplicates.

        

        After clicking the OK button, a window appears with some statistics: 1 duplicate values found and removed; 9 unique values remain. Click OK. Figure 6-5 shows the resulting table.

        
          [image: A screenshot of a spreadsheet  AI-generated content may be incorrect.]
          Figure 6-5. The product sales dataset, without duplicate rows.

        

        Tip

          Always specify the column you want Copilot to search for duplicates; otherwise, Copilot may not respond correctly.

        

        Now that you have learned how to remove missing values, let’s move on to the next task of data preparation, dealing with missing values.

      

      
        Dealing with Missing Values

        Missing values occur when no data is stored for a cell or field in a dataset where a value is expected. In Excel, a missing value may appear as a blank cell, a placeholder like N/A, or an error code such as #VALUE!.

        Missing values can depend on different factors, including, but not limited to:

        
          	Data not collected at the time of entry

          	
            Certain fields may not have been filled out because the information was unavailable at the time of data capture. For example, a customer survey might include optional fields such as email or age, which some respondents choose not to provide. 

          

          	Manual input errors or omissions

          	
            A user entering information into a spreadsheet may accidentally skip a cell or fail to update a record after a change. These omissions are often unpredictable and can be difficult to trace, especially in large datasets.

          

          	System failures or interrupted data imports

          	
            Technical glitches, such as network interruptions, software crashes, or broken data pipelines, can lead to partial imports. For example, during a batch upload, the system may crash halfway through, leaving some cells blank in some records. 

          

          	Mismatched merges from multiple sources

          	
            It’s common to encounter join mismatches when combining datasets from different sources, especially when key identifiers are missing or inconsistent. For example, merging customer transaction records with a loyalty program database may result in missing loyalty IDs if some customers never enrolled. 

          

        

        Once you’ve identified missing data in your dataset, the next step is deciding how to deal with it. Let’s see some popular techniques to deal with missing values.

        
          Techniques to Deal with Missing Values

          Table 6-1 describes the most common techniques for managing missing values in data analysis workflows, when they can be used, and some practical examples of usage. The correct approach depends on the nature of your data, the amount and pattern of missingness, and the type of analysis you plan to perform.

          
            Table 6-1. The most common techniques for managing missing values.
            
              
                	Technique
                	Description
                	Best for
                	Example
              

            
            
              
                	Deletion
                	
                  Remove rows or columns.

                  Row deletion is removing the (few) rows containing missing values.

                  Column deletion is removing a column with a large portion of missing values.

                
                	
                  There are a few missing rows (row deletion) or a significant portion of missing values in a column (column deletion).

                
                	
                  If a survey response is missing for one participant, remove that row. If a column has too many missing values, remove the column.

                
              

              
                	Default or placeholder values
                	
                  Fill missing cells with a standard placeholder, such as 0, N/A, or Unknown. 

                
                	
                  Non-critical fields, categorical columns, or when signaling that data was missing, is useful.

                
                	
                  Use “Unknown” for a missing gender entry or 0 for missing income.

                
              

              
                	Forward or backward fill
                	
                  Forward fill uses the last known value to fill missing values below it. 

                  Backward fill propagates the next known value upwards.

                
                	
                  Time-series data where the last observed state is assumed to continue temporarily.

                
                	
                  If a stock price is missing for a day, you might assume it stayed the same as the previous day.

                
              

              
                	Interpolation
                	
                  Estimates missing values based on nearby data points. This involves calculating a value that fits smoothly within the existing trend for numerical or time-series data.

                
                	
                  Linear interpolation assumes a straight line between two known values.

                
                	
                  Estimate a missing temperature reading by averaging the values before and after the missing one.

                
              

              
                	Statistical imputation
                	
                  Replace missing values with statistical measures based on the column. Mean imputation calculates the average of non-missing values.

                  Median imputation calculates the median.

                  Mode imputation calculates the most frequent value.

                
                	
                  Suitable for numerical columns when data is missing at random.

                
                	
                  Use the mean income to fill in missing income values.

                
              

              
                	Conditional imputation
                	
                  Infer missing values based on relationships with other fields.

                
                	
                  Best for structured datasets where values can be inferred from other known columns.

                
                	
                  Fill in the missing Branch Location based on the Salesperson.

                
              

              
                	Predictive Modeling
                	
                  Use machine learning models to predict missing values based on patterns in the rest of the data.

                
                	
                  Complex datasets with enough data to train a reliable model.

                
                	
                  Predict missing house prices using features like square footage, location, and number of rooms.

                
              

            
          

          These strategies enable you to handle missing data, each with its strengths and appropriate contexts. You can combine different techniques for different dataset parts to achieve the most accurate and robust results.

          Before moving to a practical exercise, let’s see how Copilot deals with all these strategies. Table 6-2 shows the suggested prompt for Copilot for each technique and the possible Copilot answers. In fact, Copilot is not a deterministic tool; thus, its provided answer for each prompt may vary.

          
            Table 6-2. Suggested prompts and possible Copilot answers for each technique to address missing values.
            
              
                	Technique
                	Suggested Prompt
                	Possible Copilot Answers
              

            
            
              
                	Deletion
                	
                  Remove rows with missing values from the table. If a column has more than 50% missing values, drop it entirely.

                
                	
                  The steps to remove missing values

                  The formula to remove missing values

                  A button to directly remove rows with missing values and a button to remove columns with more than 50% missing values

                
              

              
                	Default or placeholder values
                	
                  Fill in the missing values in the X column with the value ‘Unknown’

                
                	
                  The formula to fill in the missing values

                  Occasionally, Copilot adds a button to fill in the missing values directly.

                
              

              
                	Forward or backward fill
                	
                  Use forward fill to propagate the last valid observation forward in column X. If forward fill fails, use backward fill.

                
                	
                  A button suggesting starting advanced analysis with Python

                  The steps to apply this strategy with the formula

                
              

              
                	Interpolation
                	
                  Use linear interpolation to fill in missing values in the Value column.

                  .

                
                	
                  A button suggesting starting advanced analysis with Python

                  The formula to apply interpolation

                
              

              
                	Statistical imputation
                	
                  Impute missing values in the X column using the median of the non-missing values.

                
                	
                  A button suggesting starting advanced analysis with Python

                  The formula to apply statistical imputation

                  Occasionally, Copilot adds a button to directly apply imputation to the dataset

                
              

              
                	Conditional imputation
                	
                  Fill in missing values in the X column based on the <condition> in column Y.

                
                	
                  A button to directly apply conditional imputation to the table

                  A statement saying that Copilot can’t do that.

                  The formula to apply conditional imputation

                
              

              
                	Predictive Modeling
                	
                  Train a classification model using available data to predict and fill missing values in the X column.

                
                	
                  A button suggesting starting advanced analysis with Python

                
              

            
          

          Looking at the table, you can notice that in most cases, Copilot provides the formula and the steps to apply the required technique. Occasionally, it can apply the proposed technique directly to the data. In other cases, Copilot proposes to start advanced analysis. Click this button only if you have Python connected to Excel. Don’t worry if, for now, you can’t apply this strategy. You’ll see this aspect later in the book.

          Now that you’ve seen how Copilot’s responses can vary, let’s move on to a practical example. Don’t worry if your results differ from those described in the example because Copilot doesn’t generate answers deterministically, as mentioned earlier. What I’m offering is just one possible strategy for using Copilot. Refer to Table 6-2 to explore and compare alternative approaches. Ultimately, rely on your intuition to follow Copilot’s suggestions to guide you toward a solution.

        

        
          A Practical Example

          When using Copilot to deal with missing values, the first step is to ask it to highlight them. Consider again the product sales dataset in the book’s GitHub repository under 06/product_sales.xlsx. Open the Copilot chatbox by clicking the corresponding button in the Home ribbon. Write the following prompt for Copilot:

          Highlight missing values

          In most cases, Copilot should provide an answer similar to the one shown in Figure 6-6.

          
            [image: A screenshot of a chat  AI-generated content may be incorrect.]
            Figure 6-6. The answer provided by Copilot after asking to highlight missing values.

          

          To apply this rule, click the Apply button. Figure 6-7 shows the result after applying the rule. The dataset contains two missing values in the Branch Location column.

          
            [image: A screenshot of a spreadsheet  AI-generated content may be incorrect.]
            Figure 6-7. The dataset with the highlighted missing value rows.

          

          Before asking Copilot to apply a specific strategy to deal with missing values, write the following prompt for Copilot:

          Suggest actions for missing values.

          This prompt is helpful to understand if Copilot already knows which strategy should be applied. In my case, Copilot provided the following answer:

          For the missing values in "Table1", here are some actions you can consider:
Fill with default values: You can fill the missing "Branch Location" with a default value like "Unknown" or "Not specified".
=IF([@[Branch Location]]="","Unknown",[@[Branch Location]])
Use previous values: If the missing value is part of a series, you can fill it with the previous value in the column.
=IF([@[Branch Location]]="",H9,[@[Branch Location]])
Data validation: Ensure that future entries in the "Branch Location" column are mandatory to avoid missing values.
Highlight for review: Keep the highlighted cells for manual review and correction.
These actions can help maintain the integrity and completeness of your data.

          Copilot suggests strategies for Default or placeholder values (1) and backward fill (2). In both cases, Copilot provides the formulas to apply. Copilot also proposes performing data validation (3) and highlighting cells with missing values (4). In our specific scenario, the suggested strategies (1) and (2) are not optimal because we can derive the Branch Location from the Salesperson (Conditional imputation). Write the following prompt for Copilot: 

          Based on the Salesperson column, fill in the missing values in the Branch Location column.

          In my case, Copilot answers by proposing the formula and a button to insert the result directly into the table (Figure 6-8).

          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 6-8. The answer provided by Copilot when asked to apply conditional imputation.

          

          Click Insert column. Figure 6-9 shows the resulting table, with the new column Branch Location2 having only the first missing value (row 4) filled. The second missing value (row 6) is not filled.

          
            [image: A screenshot of a table  AI-generated content may be incorrect.]
            Figure 6-9. The result of the Insert column button provided by Copilot to fill in missing values.

          

          The missing value in row 6 is replaced with a zero (0), although the filled value should be Boston (see row 10 for comparison). The problem here is that Copilot applies a formula that searches for the first occurrence in the Branch Location corresponding to the Salesperson. The first occurrence of Branch Location for Salesperson David Green is an empty value, corresponding to zero (0). To solve the problem, ask Copilot to modify the formula:

          Modify the following formula to search for the first occurrence of a non-empty Branch Location corresponding to the Salesperson: =IF([@[Branch Location]]="", XLOOKUP([@Salesperson], [Salesperson], [Branch Location]), [@[Branch Location]])

          In my case, Copilot provides the following answer:

          =IF([@[Branch Location]]="", XLOOKUP([@Salesperson], FILTER([Salesperson], [Branch Location]<>""), FILTER([Branch Location], [Branch Location]<>""), ""), [@[Branch Location]])

          Replace the original values in the column Branch Location2 with the new formula. Figure 6-10 shows the result. 
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            Figure 6-10. The resulting table after filling in the missing values.

          

          Now ask Copilot to explain the formula:

          Explain this formula: =IF([@[Branch Location]]="", XLOOKUP([@Salesperson], FILTER([Salesperson], [Branch Location]<>""), FILTER([Branch Location], [Branch Location]<>""), ""), [@[Branch Location]]).

          In my case, Copilot provided the following explanation:

          Explanation: This formula fills in missing values in the "Branch Location" column by finding the first non-empty branch location corresponding to the same salesperson.
  • IF([@[Branch Location]]=""): Checks if the current row's "Branch Location" is empty.
    - If true, it proceeds to find the first non-empty branch location for the salesperson.
    - If false, it keeps the current "Branch Location" value.
  • XLOOKUP([@Salesperson], FILTER([Salesperson], [Branch Location]<>""), FILTER([Branch Location], [Branch Location]<>""), ""):
    - FILTER([Salesperson], [Branch Location]<>""): Filters the "Salesperson" column to include only rows where "Branch Location" is not empty.
    - FILTER([Branch Location], [Branch Location]<>""): Filters the "Branch Location" column to include only non-empty values.
    - XLOOKUP: Searches for the current row's salesperson ([@Salesperson]) in the filtered "Salesperson" list and returns the corresponding value from the filtered "Branch Location" list. If no match is found, it returns an empty string ("").
  • [@[Branch Location]]: If the "Branch Location" is not empty, it retains the current value.

          Tip

            Just for curiosity, I also asked OpenAI ChatGPT to explain the previous formula, using the same prompt, and I got a pretty similar answer to that provided by Copilot. 

          

          To confirm the theory that Copilot’s response to the same prompt is not deterministic, I gave it the same prompt as input for the second time and got a different result. The starting prompt was this: 

          Based on the Salesperson column, fill in the missing values ​​in the Branch Location column.

          Copilot provided the answer in Figure 6-11 in my second test.
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            Figure 6-11. The answer provided by Copilot to deal with missing values in the second test.

          

          In practice, Copilot suggested applying the following formula:

          =IF([@[Branch Location]]="",IF([@Salesperson]="Alice Smith","New York",IF([@Salesperson]="Bob Jones","Los Angeles",IF([@Salesperson]="Carol White","Chicago",IF([@Salesperson]="David Green","Boston","")))),[@[Branch Location]])

          The previous formula includes all the possible values for Salesperson, preventing it from being general.

        

        
          Exercise 1

          Consider the patient dataset shown in Figure 6-12, which is available in the book’s GitHub repository under 06/patients.xlsx. 
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            Figure 6-12. The patient dataset.

          

          Using Copilot, perform the following tasks:

          
            	
              Highlight missing values

            

            	
              Ask Copilot to suggest strategies for missing values, column by column

            

            	
              Apply a strategy for filling in missing values in the column Gender.

            

            	
              Apply a strategy for filling in missing values in columns Diagnosis and Blood Pressure.

            

          

          A set of possible prompts for Copilot is available under 06/patients_prompts.txt.

        

      

      
        Data Formatting

        When I buy a new product, like a phone or an appliance, I almost never read the instruction manual. And honestly, that’s a bit of a problem. Caught up in the excitement, I usually rip open the packaging and start using it right away. But inevitably, something doesn’t work as expected. That’s when I go back, manual in hand, and skim through just the parts I need.

        I have to admit, I approached Copilot the same way. I opened the chatbox and started typing whatever came to mind. The results? Not exactly impressive. It was only after I hit a wall that I decided to dig deeper, with learning about prompt engineering, exploring online resources, and watching tutorials. And the difference? Huge.

        So here’s my advice: Go ahead and experiment with your own prompts. That’s part of the fun!

        However, if you want to save time and avoid frustration, consider using proven prompts. They can give you a clearer idea of what Copilot is truly capable of and help you get better results, faster. In this section, you’ll find a set of tested prompts specifically designed for data formatting tasks with Copilot.

        Data formatting involves adjusting the structure, appearance, and consistency of data to ensure it’s clean, readable, and ready for analysis. While it doesn’t alter the underlying data itself, formatting plays a crucial role in how information is interpreted and utilized by both humans and software tools.

        If your data isn’t formatted correctly, you might run into problems like these:

        
          	Formula errors caused by text in numeric fields

          	
            Excel formulas expect specific data types (numbers, dates, text). When the format is incorrect, calculations may silently fail or throw errors. For example, a number formatted as text may look fine but won’t behave correctly in operations like SUM, AVERAGE, or mathematical comparisons.

          

          	Incorrect aggregations due to inconsistent labels

          	
            When labels vary in capitalization, spacing, or spelling, Excel treats them as distinct entries. This can lead to misleading summaries in PivotTables or grouped calculations. For example, if a column contains “Q1”, “q1”, and “ Q1 “ (with a trailing space), Excel will group these as separate categories in a PivotTable, thus fragmenting what should be a single group.

          

        

        Table 6-3 shows the most common data formatting problems in Excel.

        
          Table 6-3. Table title placeholder
          
            
              	Data Type
              	Formatting Problem
              	Description
            

          
          
            
              	Textual
              	
                Inconsistent text formatting

              
              	
                Varying use of case, spacing, special characters, or line breaks

              
            

            
              	
                Inconsistent use of symbols

              
              	
                Units or symbols embedded in text inconsistently (e.g., “50kg” vs “50 kg”)

              
            

            
              	Non-textual
              	
                Number stored as text

              
              	
                Numeric-looking values stored as text (e.g., ’1000’)

              
            

            
              	
                Date and time format Issues

              
              	
                Dates stored as text or mixed formats; locale inconsistencies

              
            

            
              	
                Inconsistent number formatting

              
              	
                Differences in decimal places, currency symbols, or thousand separators

              
            

            
              	Both
              	
                Hidden characters or formatting

              
              	
                Tabs, line breaks, or conditional formatting hiding content

              
            

            
              	
                Misuse of cell formatting for meaning

              
              	
                Using color, bold, etc., without logic or metadata backing

              
            

            
              	
                Blank or missing values misrepresented

              
              	
                Use of “N/A”, “-”, or invisible characters instead of true blanks

              
            

          
        

        Common issues in data formatting include inconsistent text or number formats, dates stored as text, merged cells, and hidden characters, all of which can disrupt calculations, filtering, and readability.

        
          Techniques to Deal with Data Formatting Issues

          Table 6-3 describes the most common techniques for managing data formatting issues and some practical examples of usage. 

          
            Table 6-4. The most common techniques for managing data formatting issues.
            
              
                	Technique
                	Description
                	Example
              

            
            
              
                	Text Standardization
                	
                  Making textual data consistent in structure, spacing, and capitalization.

                
                	
                  Convert " john DOE " to “John Doe”.

                
              

              
                	Split Text from Symbols
                	
                  Separating mixed data (e.g., values and units) into distinct components.

                
                	
                  Split “50kg” into 50 and kg.

                
              

              
                	Convert Text to Numbers
                	
                  Changing string representations of numbers into numeric values.

                
                	
                  Change ’1000 to 1000 for calculations.

                
              

              
                	Unify Date Formats
                	
                  Ensuring all date entries follow a consistent format and are recognized as dates.

                
                	
                  Convert “01/02/2023” to a standard date format.

                
              

              
                	Consistent Number Formatting
                	
                  Applying uniform formatting to numerical values (e.g., decimals, currency).

                
                	
                  Format a column as currency with two decimals.

                
              

              
                	Clear Hidden Characters
                	
                  Removing invisible or non-printable characters like tabs, line breaks, or spaces.

                
                	
                  Clean data copied from web or PDF sources.

                
              

              
                	Consistent Cell Formatting for Meaning
                	
                  Using color, bold, or other formatting to convey information without logical rules or data backing.

                
                	
                  Replace manual highlighting with a rule-based color scale (e.g., red for values < 50).

                
              

              
                	Replace Placeholders
                	
                  Substituting placeholder entries like “N/A” or “-” with standardized alternatives or blanks.

                
                	
                  Replace “N/A” with a blank or default label.

                
              

            
          

          The described techniques are not exhaustive, but they provide an idea of how to deal with data formatting problems.

          Before moving on to a practical example, let’s investigate how you can use Copilot to apply the described techniques. Table 6-4 presents a suggested prompt for each technique, along with the possible prompts provided by Copilot.

          
            Table 6-5. Suggested prompts and possible Copilot answers for each technique to address data formatting issues.
            
              
                	Technique
                	Suggested Prompt
                	Possible Copilot Answers
              

            
            
              
                	Text Standardization
                	
                  Standardize the text in column X: trim extra spaces and use proper capitalization.

                
                	
                  A formula using =PROPER(TRIM(@X))

                  A column preview with cleaned-up names, with a button to apply formatting.

                  A formula using =TEXTJOIN(" ",TRUE,PROPER(TRIM(Table[@X])))

                
              

              
                	Split Text from Symbols
                	
                  Split column X into two separate columns: numeric values and units (e.g., “50kg” into “50” and “kg”).

                
                	
                  A preview table with the results and an Insert columns button.

                  Two formulas, one for each column, such as: =IFERROR(LOOKUP(9.9E+307,--TEXTSPLIT([@X],{"kg","g","mg"})),0)

                  
                    =IFERROR(TEXTAFTER([@X],TEXT(LOOKUP(9.9E+307,--TEXTSPLIT([@X],{"kg","g","mg"})),"0")),[@X])
                  

                
              

              
                	Convert Text to Numbers
                	
                  Convert all text-formatted numbers in column X to actual numbers.

                
                	
                  A button to apply the following changes: number format on column X; Autofit column(s)

                
              

              
                	Unify Date Formats
                	
                  Convert all dates in column X to the format YYYY/MM/DD.

                
                	
                  A button to apply the following changes: date/time on column X; Autofit column(s)

                
              

              
                	Consistent Number Formatting
                	
                  Format all numbers in column X to show two decimal places and use comma separators.

                
                	
                  A button to apply “Number” format with specific decimal and thousand separators.

                
              

              
                	Clear Hidden Characters
                	
                  Clean hidden characters (e.g., line breaks, tabs) from column X.

                
                	
                  A formula using =TRIM(CLEAN([@X]))

                  Occasionally, Copilot proposes a button to apply the following change: Clear the content of some cells (this solution is not correct).

                
              

              
                	Consistent Cell Formatting for Meaning
                	
                  Create a conditional formatting rule for column X: highlight values based on thresholds: <10 red, between 11 and 100 yellow, > 101 green.

                
                	
                  A button to apply the rule.

                
              

              
                	Replace Placeholders
                	
                  Replace placeholder values like “N/A” or “-” in column X with blank cells (or a default value).

                
                	
                  A Find and Replace operation 

                  A formula using =IF(OR([@X]="N/A",[@X]="-"),"",[@X])

                  Occasionally, Copilot proposes a button to apply the following change: Clear the content of some cells (this solution is not correct).

                
              

            
          

          Alternatively, Copilot provides another feature to manage data formatting issues, namely the Clean Data button in the Data tab of the Ribbon (Figure 6-13).

          
            
            Figure 6-13. The Clean Data button in the Data tab of the Ribbon.

          

          Clicking this button enables you to solve some data formatting issues, including removing extra spaces, making text in cells consistent, and formatting number columns consistently. However, at the time of writing this chapter, this feature is not fully implemented and, in some cases, can fail to recognize problems.

          At this point, you are ready to practice with an example.

        

        
          A Practical Example

          Consider the sample movie dataset in the book’s GitHub repository, located under 06/movies.xlsx and illustrated in Figure 6-14.

          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 6-14. The Clean Data button in the Data tab of the Ribbon.

          

          The dataset contains information about individuals’ movie preferences and their feedback. It includes the following columns:

          
            	Name

            	
              The full name of the individual

            

            	Age

            	
              The individual’s age

            

            	Favorite Genre

            	
              The preferred movie genre of the individual

            

            	Rating

            	
              The individual’s rating of the movie

            

            	Feedback

            	
              Textual comments about the movie

            

            	Date Watched

            	
              The date when the movie was watched

            

          

          The dataset contains several inconsistencies, such as inconsistent capitalization, text-based ratings, and missing values. Let’s use Copilot to address these problems. Open the Copilot chatbox by clicking the corresponding button in the Home Ribbon. Write the following prompt for Copilot:

          Standardize the text in the column Name: trim extra spaces and use proper capitalization.

          In my case, Copilot answered with the output shown in Figure 6-15.

          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 6-15. The answer provided by Copilot after providing the following prompt: Standardize the text in the column Name: trim extra spaces and use proper capitalization.

          

          Click Insert Column or manually apply the formula. This will convert entries like " JOHN doe " to “John Doe” and remove extra spaces or capitalization inconsistencies. Figure 6-16 shows the resulting column with the standardized names.

          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 6-16. The movie dataset with a new column for the standardized names.

          

          Next, address another common formatting issue: numbers stored as text. Write the following prompt for Copilot:

          Convert all text-formatted numbers in the Age column to actual numeric values.

          In my case, Copilot provided the answer shown in Figure 6-17.

          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 6-17. The answer provided by Copilot after providing the following prompt: Convert all text-formatted numbers in the Age column to actual numeric values.

          

          Apply the formula or follow the instructions to convert values. Figure 6-18 shows the cleaned numeric column. 

          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 6-18. The movie dataset with a new column for the converted age.

          

          Note that Copilot has replaced the missing value for Jane Doe with 0 (zero). This could be a problem, so before solving data formatting issues, I suggest that you address missing values.

          Now, fix the date format inconsistency in the Date Watched column. Use this prompt:

          Convert all dates in the column Date Watched to the format YYYY-MM-DD.

          In my case, Copilot provided the answer shown in Figure 6-19.

          
            [image: A screenshot of a chat  AI-generated content may be incorrect.]
            Figure 6-19. The answer provided by Copilot after providing the following prompt: Convert all dates in the column Date Watched to the format YYYY-MM-DD.

          

          After applying the suggested changes, you should obtain the result shown in Figure 6-20.

          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 6-20. The movie dataset with a new column for the converted format in Data Watched.

          

          As shown in the figure, Copilot correctly applied the formatting only to the cells that were already recognized as dates. However, the second row remains incorrectly formatted. To fix this problem, write the following prompt for Copilot:

          Suggest how to remove quotation marks from the column Date Watched.

          The solution proposed by Copilot in my case didn’t solve the problem. Thus, I engaged the conversation shown in Figure 6-21 with Copilot.

          
            [image: A screenshot of a chat  AI-generated content may be incorrect.]
            Figure 6-21. The conversation with Copilot to solve the date formatting problem.

          

          When I prompted Copilot that its proposed formula didn’t work, Copilot immediately proposed the following alternative formula:

          =SUBSTITUTE(TEXT([@[Date Watched]],"yyyy-mm-dd"),"""","")

          Figure 6-22 shows the result after applying the previous formula to a new column.

          
            [image: A screenshot of a computer  AI-generated content may be incorrect.]
            Figure 6-22. Column3 is a new column with corrected dates.

          

          
            When you open a workbook with formatting issues, Copilot can automatically detect them and suggest corrections through a notification (Figure 6-23).

            
              [image: A screenshot of a computer  AI-generated content may be incorrect.]
              Figure 6-23. When you open a new workbook with formatting issues, Copilot may suggest cleaning your data.

            

            Click the Show suggestions button, and the Copilot chatbox opens. You should see the two boxes shown in Figure 6-24.

            
              [image: A screenshot of a computer  AI-generated content may be incorrect.]
              Figure 6-24. The suggestions provided by Copilot to clean the dataset.

            

            In my case, Copilot suggested correcting inconsistent number format in column B and inconsistent text in column C. Click Apply in both cases. The result is shown in Figure 6-25.

            
              [image: A screenshot of a computer  AI-generated content may be incorrect.]
              Figure 6-25. The movie dataset with columns B and C cleaned.

            

          

        

        
          Exercise 2

          The movie dataset shown in Figure 6-25 still contains some formatting problems in columns Favorite Genre, Rating, and Feedback. Use Copilot to format the dataset properly.

        

        
          Exercise 3

          Consider again the patient dataset available in the book’s GitHub repository under 06/patients.xlsx. 

          Using Copilot, perform the following tasks:

          
            	
              After removing the quotation marks, format the Age column as numbers. If required, align values to the right

            

            	
              After removing quotation marks, format the Billing Amount column as currency

            

            	
              Format the Admission Date column properly.

            

          

          A set of possible prompts for Copilot is available under 06/patients_prompts_formatting.txt.

          ChallengeIs your dataset now cleaned? If not, identify what is still required to format your dataset properly and ask Copilot to clean it properly.

          
            Keep the Fire Alive

            Perhaps you began this journey filled with excitement. Or maybe with a bit of hesitation.

            Maybe you opened Copilot with the hope of instant answers to find confusion, silence, or unexpected results. And if that happened, let me say this clearly: that’s okay. That is learning.Learning to work with data and with a tool like Copilot isn’t about mastering everything at once. It’s about patience. It’s about persistence. It’s about meeting resistance and choosing to try again.

            I’m reminded of a winter day from my childhood, in a house tucked high in the mountains.

            We heated our home with a wood-burning fireplace, and one afternoon, my mother asked me to tend the fire. Proud and confident, I took the tools in hand… and did it all wrong. Logs moved aimlessly, smoke thickened, and the flame nearly died. My mother gently offered guidance, but I refused. I wanted to do it my way. In the end, she stepped in, fixed it, and I stood by, arms crossed, not because I had learned, but because I hadn’t let myself learn.

            It took me years to understand what really failed that day: not my technique, but my pride.

            To learn, we must first accept that someone might know more than we do. And that’s not weakness. That’s growth.

            If you’ve struggled with Copilot, if it hasn’t worked the way you hoped, don’t give up.

            Let go of the need to be perfect. Be curious. Be humble. Ask questions. Search for answers.

            There’s no shame in learning from others. On the contrary, it’s the fastest path forward.

            Because every prompt you write, every small frustration, every tweak and retry, they’re sparks.

            Sparks that will catch. Sparks that will become momentum. That’s how we move from confusion to clarity, from doubt to discovery. So don’t stop now. Keep going, one step, one prompt, one breakthrough at a time.

          

        

      

      
        Summary

        In this chapter, you learned how to use Copilot within Excel to prepare data through three key tasks: removing duplicates, dealing with missing values, and formatting.

        
          	
            Copilot helps clean your data by identifying and highlighting duplicate entries. While it can’t remove duplicates automatically, it guides you through Excel’s built-in tools for doing so, ensuring data integrity before analysis.

          

          	
            Copilot helps you handle missing values by suggesting strategies such as deletion, default replacements, and imputation. Depending on the context, Copilot offers formulas, interactive buttons, or Python integration to effectively fill in gaps.

          

          	
            Use Copilot to fix data formatting issues such as inconsistent text, dates stored as text, or numbers formatted incorrectly. It recommends formulas and applies standard formatting to make your data consistent and analysis-ready.

          

        

      

      
        Activity

        Complete the following text using the keywords indicated below. The solution is in Appendix A.

        DATA FORMATTING - INSIGHTS - COPILOT - MISSING VALUES - PREPARATION - DUPLICATES - PROMPT - HIGHLIGHTING RULES

        In this chapter, you learned how important proper data __________is before any analysis.

        To support this process, you explored how to structure an effective __________when interacting with __________inside Excel.

        Three core operations were covered: identifying and removing __________, addressing__________, and applying consistent __________.

        Each of these steps is essential to eliminate noise, correct errors, and ensure that your data can generate reliable __________.

        For instance, giving Copilot clear and specific instructions allows it to respond more effectively to your needs. Meanwhile, tools such as __________ and customized formulas support the reliability and consistency of your dataset.

        Keep in mind: preparing data isn’t just a technical step; it’s what allows patterns to surface, errors to be minimized, and meaningful conclusions to be drawn with confidence.

      

    



      Appendix A. Solutions to Fun Activities

      
      
A Note for Early Release Readers


With Early Release ebooks, you get books in their earliest form—the author’s raw and unedited content as they write—so you can take advantage of these technologies long before the official release of these titles.


This will be Appendix D of the final book. Please note that the GitHub repo will be made active later on.


If you have comments about how we might improve the content and/or examples in this book, or if you notice missing material within this chapter, please reach out to the editor at ccollins@oreilly.com.



      
        Chapter 1

        
          [image: A crossword puzzle with black text  AI-generated content may be incorrect.]
          Figure A-1. Placeholder

        

      

      
        Chapter 2

        In this chapter, you learned how to structure an effective PROMPT to best use CHATGPT in Excel, organizing it into three fundamental parts: context, main point, and end. The CONTEXT defines the data and information necessary to frame the problem, the MAIN POINT describes the action required, while the END indicates how to use the result.

        ChatGPT can be used as an ASSISTANT to perform various tasks, such as generating formulas for CALCULATION (for example, summing or averaging) or performing search operations with functions like VLOOKUP. This combination of strategies helps you improve productivity, automate complex calculations, and quickly resolve problems in your datasets.

      

      
        Chapter 3

        
          [image: A crossword puzzle with black letters  AI-generated content may be incorrect.]
          Figure A-2. Placeholder

        

        
          Autofill

          AUTOFILL IN EXCEL COMPLETES PATTERNS OR DATA AND AI SPEEDS IT.

        

      

      
        Chapter 4

        
          [image: A crossword puzzle with black and white squares  AI-generated content may be incorrect.]
          Figure A-3. Placeholder

        

      

      
            
        Chapter 5

        
          Figure A-4. Placeholder

        

      

      
                  
        Chapter 6

In this chapter, you learned how important proper data PREPARATION is before any analysis. To support this process, you explored how to structure an effective PROMPT when interacting with COPILOT inside Excel.


Three core operations were covered: identifying and removing DUPLICATES, addressing MISSING VALUES, and applying consistent DATA FORMATTING.
Each of these steps is essential to eliminate noise, correct errors, and ensure that your data can generate reliable INSIGHTS.


For instance, giving Copilot clear and specific instructions allows it to respond more effectively to your needs. Meanwhile, tools such as HIGHLIGHTING RULES and customized formulas support the reliability and consistency of your dataset.

Keep in mind: preparing data isn’t just a technical step; it’s what allows patterns to surface, errors to be minimized, and meaningful conclusions to be drawn with confidence.
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Looking at ATHIO, here’ 1 formula column to review and insert in Colum |

Branch Location2

Fills in missing branch locations based on the salesperson's name, assigning “New York" for Alice
Smith, for Bob Jones, "Chicago" for Carol White, and “Boston for David Green. If the
branch location is already provided, it keeps the existing value.

$ (]
=IF([@[Branch Location]] ,IF([Qsalesparson]
York”, IF ([@salesperson]="Bob Jones”,"Los Angeles”,IF ([@salesperson]="Carol

chizagon T [@Sa1esperson]="oavid Grem ), [elsranch
Location]])

Show explanation v/

Branch Location2
New York

Los Angeles

New York

Chicago

+ Insert column

49
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Looking at ALF9, here's 1 formula column to review and insertin Column G:
Standardized Name

Standardizes the formatting of names by removing extra spaces and capitali
word, ensuring consistency and readabilty across entries in the table.

< 0

=PROPER(TRIM( [GName]))

g the first letter of each

Show explanation v

Standardized Name.
John Doe

Alice Smith

Bob.

Jane Doe

+ Insert column
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Looking at AT:H10, here's 1 formula column to review and insert in Column H:

Branch Location2
Fills in missing branch locations by looking up the salesperson’s branch location from other entries in
the table

e 0
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To remove quotation marks from the "Date Watched" column, you can use the following formula in a
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e (1]

=SUBSTITUTE([@[Date Watched]],

This formula uses the SUBSTITUTE function to replace all double quotation marks (*) with an empty
string. Apply this formula to the "Date Watched column in your table.
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@ Copilot  Ageneated content may b ncorect

The isue with the formula =SUBSTITUTE([@[Date Watched]],"""","") is that it does not
correctly handle the quotation marks in the “Date Watched" column because the column contains
dates formatted as numbers, not text.

To fx this, you need to first convert the cel value to text before applying the SUBSTITUTE function.
Here's the corrected formula:

$x (1]

=SUBSTITUTE(TEXT([@[Date Watched]], "yyyy-mm-dd”

This formula ensures the date s converted to text in the desired format (*yyyy-mm-dd") and then
removes any quotation marks. Apply this formula to the “Date Watched" column.
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for '#N/A' is 4896. See the table above for more details.
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